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1 Einleitung 

1.1 Thrombozyten 

Thrombozyten sind scheibenförmige, korpuskuläre, 0,5-0,75 μm dicke und im Durchmesser        

1-4 μm große, kernlose Zellen. Sie werden im Knochenmark durch Zytoplasmaabschnürung 

aus Megakaryozyten gebildet. Die Zahl der Thrombozyten im Blut beträgt zwischen 150.000 

und 300.000 Zellen pro μl, die circa sieben Tage im Blut zirkulieren, bis sie im retikulären 

System von Leber, Milz und Lunge abgebaut werden. Zudem dient die Milz als 

Thrombozytenspeicherort, sie speichert circa ⅓ der Thrombozyten, die mit den zirkulierenden 

Thrombozyten im Austausch stehen (Gawaz, 1999). 

Im Blut zirkulieren ruhende diskoide Thrombozyten (Abb. 1 A), welche durch Interaktionen 

mit verletzten Gefäßen oder durch das Zusammenspiel mit bestimmten Faktoren (z. B. ADP, 

Thrombin, Kollagen) aktiviert werden können. Durch ihre Aktivierung können diese ihre 

Form verändern, wobei sich die Oberfläche auf 13 μm2 vergrößert. Es erfolgt die Ausstülpung 

von Pseudopodien, die mit einer mehrfachen Oberflächenvergrößerung einhergeht (Abb. 1 B). 

Die Pseudopodien spreizen sich, um eine effektive Abdichtung der Gefäßwandläsion zu 

erzielen (Abb. 1 C). Anschließend sezernieren die thrombozytären Granula ihre Inhaltsstoffe 

(z. B. Thromboxan A2, ADP), welche den Aktivierungsvorgang verstärken und die noch 

ruhenden Thrombozyten stimulieren (Siess, 1989). Thrombozyten nehmen eine 

Schlüsselfunktion bei der Auslösung arterieller Thrombosen ein. Sie sind das zelluläre 

Element der primären Hämostase und können so Aggregate bilden, die an einer 

Verletzungsstelle einen Gefäßdefekt wirkungsvoll verschließen. Sie besitzen eine 

Lipiddoppelmembran, in der verschiedene Glykoproteine (GP) eingebaut sind, wie αIIbβ3- und 

GPIb, wobei bis heute nur ein Teil ihrer Funktion bekannt ist.  

Abbildung 1: Rasterelektronenmikroskopische Aufnahme von ruhenden und aktivierten Thrombozyten
Dargestellt sind ruhende Thrombozyten, die im Blut zirkulieren und eine bikonvexe scheibenähnliche Form 
besitzen (A), wobei sie nach Stimulierung reversible Pseudopodien ausbilden (B). Nach Aktivierung (C) stülpen 
die Thrombozyten lange Fortsätze aus und es kommt zu einer stabilen Adhäsion. (entnommen aus www.platelet-
research.org)

CBA
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1.1.1 Funktion der Thrombozyten in der Hämostase 

Hämostase ist ein Prozess, der vorwiegend nach einer Blutgefäßverletzung auftritt und die 

Gerinnung des Blutes hervorruft, wobei ein Gefäßwandthrombus gebildet wird. Die 

Reaktionsschritte beinhalten die Adhäsion, Bildung von Pseudopodien, Freisetzung der 

Thrombozytengranula und Aggregation.  

Kommt es zur Verletzung eines Blutgefäßes, verbindet sich das austretende Blut mit dem 

umliegenden kollagenhaltigen Bindegewebe. Im ersten Schritt lagern sich die Thrombozyten 

an die Kollagenfasern an (Thrombozytenadhäsion) und decken den Bereich der Wunde ab. 

Die Adhäsion der Thrombozyten führt zu deren Aktivierung, die durch Kontakt mit von-

Willebrand-Faktor (vWF) oder Kollagen vermittelt wird. vWF ist ein Blutprotein, das von 

Megakaryozyten und Endothelzellen gebildet wird. 

Zusätzlich sind Thrombozyten während der Adhäsion Scherkräften ausgesetzt, die eine 

schwache αIIbβ3-Integrinaktivierung verursachen (Ozaki, 2005; Ruggeri, 2007). Scherkräfte 

verstärken die integrinbasierende Adhäsion durch das Induzieren einer 

Konformationsänderung des Zytoskelettproteins Talin. Talin formt daraufhin mit einem 

weiteren Zytoskelettprotein, genannt Vinculin, einen Komplex (Lee, 2007; del Rio, 2009). 

Dieser Komplex wiederum wirkt wie eine molekulare Kupplung zwischen dem Zytoskelett 

und den Integrinen (Hu, 2007). Dieser Mechansimus ist hauptsächlich verantwortlich für die 

initiale Bildung der Thrombozytenaggregate (Nesbitt, 2009).  

Die Thrombozyten verknüpfen sich untereinander über aktiviertes αIIbβ3-Integrin und 

Fibrinogen. Es bildet sich ein weißer Thrombozytenpfropf (weißer Thrombus), der mit der 

Vasokonstriktion, ausgelöst durch Thromboxan A2, das Ergebnis der primären Hämostase 

bildet. Anschließend setzen die aktivierten Thrombozyten Substanzen frei (Kalzium-Ionen, 

ADP, Serotonin, Thromboxan A2), die die Gerinnungskaskaden in Gang setzen und 

schließlich Fibrinogen in unlösliches Fibrin umwandeln. Es entsteht ein als roter Thrombus 

bezeichnetes Netz aus stabilem Fibrin, Thrombozyten und Erythrozyten. Über αIIbβ3-Integrin, 

das die Thrombozyten mit Fibrinogen zusammen quervernetzt, kommt es zur Kontraktion, 

wobei das Wasser aus dem Gerinnsel herausgepresst wird, sodass sich ein fester Pfropf bilden 

kann. 

Kardiovaskuläre Erkrankungen mit thrombotischem Charakter, wie zum Beispiel 

Myokardinfarkten (Bhatt, 2003) und Schlaganfällen (Stoll, 2008), gelten in den 

Industriestaaten als Haupttodesursache (Bougie, 2002; Braunwald, 1997).  
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1.2 Integrine 

Integrine sind heterodimere Adhäsionsrezeptoren, die aus einer α- und einer β-Untereinheit 

bestehen. Es handelt sich um Glykoproteine, die dauerhaft  in der Zellmembran eingebettet 

sind und die eine wichtige Rolle in der Zell-Zell- und Zell-Oberflächen-Adhäsion einnehmen. 

Sie verbinden unter anderem die Strukturen des Zytoskeletts mit der extrazellulären Matrix 

(Hynes, 1992). Integrine können sich auf Zelloberflächen durch Clustering und Recycling neu 

anordnen (Cluzel, 2005). Die Untereinheiten durchdringen die Zellmembran und haben 

folglich einen intrazellulären, einen transmembranen und einen extrazellulären Anteil (Hynes, 

1992). Bekannt sind 18 verschiedene α- und acht verschiedene β-Untereinheiten, die sich zu 

24 verschiedenen Heterodimeren kombinieren und spezifische bzw. überlappende Funktionen 

aufweisen (Humphries, 2006).  

Ein extrazellulär gelegener globulärer Kopf ist über die α- und β-Untereinheit mit der 

Zellmembran verbunden (Carrell, 1985). Alle α-Untereinheiten haben im N-terminalen 

Bereich spezielle Bindungsstellen für divalente Kationen. Für die Funktionalität des 

Rezeptors sind diese Bindungsstellen essenziell, da sie die Affinität und die Spezifität für die 

Liganden beeinflussen (Plow, 2000). Die Erkennung der Liganden erfolgt meist über die 

Tripeptidsequenz Arg-Gly-Asp (RGD) (Plow, 2000), deren Sequenz ebenfalls in die für die 

Zelladhäsion verantwortlichen Proteine wie Fibrinogen, Fibronektin, Vitronektin, exprimiert 

wird.  

Die Integrine sind Gegenstand intensiver Forschung, vor allem auf dem Gebiet der αvβ3-

selektiven Verbindungen, die in Zusammenhang mit Arthritis, Retinopathie, Osteoporose und 

Tumorerkrankung stehen (Miller, 2000), sowie der αIIbβ3-selektiven Verbindungen, die eine 

wichtige Rolle in der Blutgerinnung spielen (Weller, 1996; Goodman, 2002). Die 

Modifizierung der Bindung zwischen Integrinen und Liganden ist für die Forschung von 

großem Interesse, um neue Arzneistoffe zu entwickeln. 

1.2.1 Integrinkonformationen und Aktivierung 

Rezeptoraktivierung bezeichnet den Übergang des ruhenden, inaktiven Rezeptors in eine 

aktivierte Form, die eine deutlich höhere Neigung zur Interaktion mit Liganden aufweist. 

Diese Art der Konformationsänderung ermöglicht der Zelle, schnell auf ihre Umgebung zu 

reagieren. Das Prinzip des veränderlichen Rezeptors liegt vielen Prozessen zu Grunde, wie 

zum Beispiel der Blutstillung, Thrombose, Zellmigration und Metastasierung (Hynes, 1992; 

Dedhar, 1996; Humphries, 1996; Tozer, 1996; Hughes, 1998). Integrine sind keine starren 

Moleküle, sondern befinden sich in einem ständigen Gleichgewicht zwischen verschiedenen 
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Formen (Xiao, 2004). Für Integrine können drei distinkte Konformationen nachgewiesen 

werden (Abb. 2). Bei der niedrig affinen, gekrümmten Konformation ist der Rezeptorkopf in 

Richtung der Zelloberfläche abgeknickt (Abb. 2 A). In der mittel affinen Konformation mit 

geschlossenem Kopfteil sind die Schenkel gestreckt (Abb. 2 B). Die Bindung von Liganden 

an den Rezeptor induziert den Wechsel zur hoch affinen gestreckten Konformation mit 

geöffneter Kopfregion, in der der Winkel zwischen β3I-Domäne und Plexin/ 

Semaphorin/Integrin(PSI)-Domäne von spitzwinklig zu stumpfwinklig wechselt (Abb. 2 C). 

Abbildung 2: Drei distinkte Konformationen der Integrine 
Drei mittels Röntgen-Kristallographie nachgewiesene Konformationen eines Integrins mit Kennzeichnung der 
verschiedenen Domänen (Xiao, 2004). A: niedrig affine, gekrümmte Konformation; B: mittel affine, gestreckte 
Konformation mit geschlossenem Kopfteil; C: hoch affine, gestreckte Konformation mit geöffnetem Kopfteil.  

Allosterische Effekte in der β3I-Domäne verändern die Struktur von drei metallischen 

Bindungsstellen, assoziierten Schleifenstrukturen und zwei α-Helices. Dies bewirkt eine 62°-

Reorientierung zwischen der β3I-Domäne und der Hybrid-Domäne. Die Übertragung der 

Strukturänderung über die starr verbundene PSI-Domäne im oberen Teil des β3-Schenkels 

führt zu einer Separation der α- und β-Schenkel um 70 Å (Xiao, 2004). Intrazelluläre Signale 

bewirken also eine Verschiebung des Gleichgewichts der verschiedenen 

Integrinkonformationen hin zur hoch affinen gestreckten Form. Aktivierte αIIbβ3-Integrine 

stimulieren Signalkaskaden im Zellinneren, die unter anderem zu Veränderungen der 

Zytoskelettstruktur führen (Vijayan, 2006). Integrine sind in der Lage, Informationen 

bidirektional zu übertragen, wobei die Signale entlang eines allosterischen Pfads 

weitergeleitet werden (Arnaout, 2005) und sich dabei die Transmembran-Domänen räumlich 

voneinander trennen (Kim, 2003).  
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1.2.2 αIIbβ3-Integrin

Der Rezeptor αIIbβ3-Integrin, auch GPIIb-IIIa genannt, besteht aus einer αIIb- und einer β3-

Untereinheit, die beide in der Plasmamembran verankert sind (McEver, 1983). Die αIIb-

Untereinheit ist zusammengesetzt aus einer schweren (105 kDa) und einer leichten 

Proteinkette (25 kDa), die durch eine Disulfidbrücke zusammen gehalten werden. Bei der β3-

Untereinheit handelt es sich um eine 105 kDa schwere durchgehende Proteinkette (Phillips, 

1987; Calvete, 1999). Die β3-Expression wird auf Transkriptionsebene kontrolliert (Zutter, 

1992). Die αIIb-Vorstufe wird in Megakaryozyten als einzelne Polypeptidkette synthetisiert, 

mit der β3-Untereinheit zum pro-αIIbβ3-Komplex assoziiert und anschließend in den Golgi-

Apparat transportiert. Im Golgi-Apparat wird die pro-αIIb-Untereinheit des Komplexes in die 

schwere und die leichte Kette gespalten. Anschließend wird der reife αIIbβ3-Komplex an die 

Zelloberfläche transportiert (O´Toole, 1989). 

Die Gene sind auf Chromosom 17 in der Region q21-22 lokalisiert (Sosnoski, 1988). Es ist 

eines der ersten Integrine, das identifiziert (Nurden, 1974), aufgereinigt (Jennings, 1982), 

kloniert und sequenziert (Fitzgerald, 1987; Loftus, 1987, Poncz, 1987) wurde. Zentrale 

Aufgabe des Rezeptors ist die Bindung von löslichem Fibrinogen an die Oberfläche 

aktivierter Thrombozyten, dem ersten Schritt der Thrombozytenaggregation. 

Der Rezeptor ist ein für Thrombozyten spezifisches heterodimeres Integrin und mit 1-2 % des 

Gesamtproteingehalts und einer Oberflächenbesetzung von 60.000-100.000 Rezeptoren pro 

Thrombozyt das am häufigsten vorkommende Glykoprotein (Yee, 2004; Jennings, 1982; 

Wagner, 1996). 70 % dieser Rezeptoren liegen konstitutiv auf der Thrombozytenoberfläche 

vor. Die übrigen 30 % werden erst nach Aktivierung der Thrombozyten aus intrazellulären 

Speichern (offenes kanalikuläres System und α-Granula) zur Oberfläche transportiert und dort 

präsentiert (Topol, 1999; Wencel-Drake, 1986, Woods, 1986).  

Eine Aktivierung der Thrombozyten führt zu einer Konformationsänderung des αIIbβ3-

Integrins und damit zur Freilegung von hoch affinen Fibrinogenbindungsstellen, wodurch 

eine Bindung von Agonisten wie löslichem Fibrinogen ermöglicht wird. Nicht aktivierte 

Rezeptoren können nur immobilisiertes Fibrinogen binden. Die Konformationsänderung des 

αIIbβ3-Integrins ist mehrstufig (Abb. 2). So gibt es den niedrig affinen, ruhenden Zustand, bei 

dem Liganden kaum vom Rezeptor gebunden werden (Phillips, 1991), den hoch affinen, 

aktivierten Zustand (ausgelöst durch Mn2+, Ca2+, RGD-Liganden), in dem der Rezeptor 

Liganden binden kann (Takagi, 2002) und den geöffneten Zustand nach Ligandenbindung 

(Hantgan, 1999; Gottschalk, 2002). Die Bindung von Fibrinogen an den aktivierten αIIbβ3-

Integrin erfolgt stöchiometrisch im Verhältnis 1:1 und induziert eine zweite 
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Konformationsänderung des Rezeptors mit Freilegung von kryptischen Epitopen. Diese 

Konformationsänderung ist wesentlich für die irreversible Fibrinogenbindung sowie die 

transmembranäre Signaltransduktion verantwortlich. So können Mutationen in einer der 

beiden Untereinheiten eine veränderte Rezeptorfunktion mit schwerwiegenden Folgen für die 

Betroffenen verursachen. Die Anwendung von αIIbβ3-Antagonisten, wie der Antikörper 

Abciximab, ist in der klinischen Anwendung durch Nebeneffekte wie unerwünschte 

Blutungen begrenzt (Adams, 2008; Kleinschnitz, 2009; Quinn, 2003). 

1.2.3 αIIbβ3-Integrin-abhängige Thrombozytenaktivierung 

Eine Konformationsänderung des αIIbβ3-Integrins führt zu einer Bindung von Liganden, 

vermittelt über die Tripeptidsequenz RGD. Die α-Untereinheit des αIIbβ3-Integrins hat N-

terminal eine Bindungsstelle für RGD-Liganden und Kalzium, C-terminal verfügt sie über ein 

GFFKR-Motiv. Das GFFKR-Motiv hält den Rezeptor in seiner ruhenden Konformation. 

Kommt es zu einer Deletion dieses Motives, so liegt der Rezeptor konstitutiv in der aktiven 

Konformation vor (O´Toole, 1994; Peter, 1996). Die Aufrechterhaltung der heterodimeren 

Struktur wird unter anderem durch Kalzium-Ionen gewährleistet (Kunicki, 1981; Fujimura, 

1983). Die beiden Integrin-Untereinheiten formen eine dreidimensionale Liganden-

Bindungstasche (Plow, 2000). Die β-Untereinheit besitzt eine MIDS-Domäne (Metal Ion 

Dependent Adhesion Site), die ebenfalls für ein RGD-Motiv verantwortlich ist (Plow, 2000). 

Liganden, die eine RGD-Sequenz aufweisen, binden reversibel und im  stöchiometrischen 

Verhältnis von 1:1 am αIIbβ3-Integrin (Phillips, 1991).   

Der zytoplasmatischen Schwanzdomäne des αIIbβ3-Integrins wird keine intrinsische 

enzymatische Aktivität zugesprochen (van der Flier, 2001). Dementsprechend müssen 

zytoplasmatische Proteine, welche an diese Domäne binden, eine wichtige Rolle bei der 

Initiierung und Weiterleitung des bidirektionalen Signalings spielen. Mehr als 

20 zytoplasmatische Proteine wurden als Bindungspartner der zytoplasmatischen αIIbβ3-

Integrin-Schwanzdomäne identifiziert (Liu, 2000), die hauptsächlich mit dem Outside-in-

Signaling verlinkt sind. Eine der essenziellsten zytosolischen Proteine sind Talin und Kindlin, 

welche in der Lage sind, Integrine mit dem Aktin-Zytoskelett zu verknüpfen. Die β-

Untereinheit bildet mit Talin und Kindlin einen Komplex, worauf die α-Untereinheit 

verdrängt wird, die Transmembran-Domänen getrennt werden und es zur Integrinaktivierung 

kommt (Tadokoro, 2003; Wegener, 2007; Wegener, 2008; Moser, 2008; Anthis, 2009; 

Nieswandt, 2007; Petrich, 2007; Ma, 2008; Montanez, 2008; Moser, 2008). Ein Beweis für 

die Notwendigkeit von Talin und Kindlin in der Thrombozytenaktivierung wurde in Studien 
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mit Talin-1- und Kindlin-3- defizienten Mäusen gezeigt (Nieswandt, 2007; Petrich, 2007; 

Moser, 2008; Meves, 2009). Die Thrombozyten der Talin-1- und Kindlin-3-defizienten 

Mäusen konnten nicht aktiviert werden. 

Der Rezeptor ist während der Thrombozytenaggregation mit dem Zytoskelett assoziiert 

(Phillips, 1983) und in die Ligandenerkennung, transmembrane Signalübertragung, 

Konformationsänderung und Thrombozytenvernetzung involviert (Newman, 1991). Die 

Rezeptoraffinität ist in ruhenden Thrombozyten für lösliche Liganden niedrig (Shattil, 1995), 

während sie für immobilisiertes Fibrinogen hoch ist (Savage, 1992). Die 

Thrombozytenaktivierung kann in-vitro unter anderem durch ADP oder Epinephrin induziert 

werden (Bennett, 1979; McEver, 1983). Bei einer Aktivierung kommt es zur Freilegung neuer 

Epitope an der Zelloberfläche, den so genannten LIBS (Ligand induced binding site) 

(Frelinger, 1988; Frelinger, 1991). Während die αIIbβ3-Integrine im Ruhezustand gleichmäßig 

über die Thrombozytenoberfläche verteilt sind, kommt es nach einer Aktivierung zur 

Zusammengruppierung der Rezeptoren auf der Zelloberfläche. Dieses so genannte Rezeptor-

Clustering bedingt auch eine Neuanordnung des mit den Rezeptoren verbundenen 

Zytoskeletts (Cluzel, 2005). Die erhöhte Ligandenbindungsstärke und -geschwindigkeit sind 

auf das Integrin-Clustering zurückzuführen (Kasemo, 1999; Puleo, 1999). Durch das Clustern 

werden die Integrine mit den Aktin-Fasern über α-Actinin, Talin und Vinculin 

(Strukturproteine) unter anderem mit Paxillin und Tensin verknüpft, welche über Rho-

GTPasen Rho, Rac und Cdc42 organisiert werden (Friedlander, 1995; Clover, 1992; Rezania, 

1999).  

Das αIIbβ3-Integrin ist unter anderem für die Signaltransduktion zuständig, die man sich nicht 

wie einen linearen Weg biochemischer Interaktionen vorstellen darf. Es handelt sich vielmehr 

um ein interagierendes kompliziertes Netzwerk (Arnout, 2005). Bei der Signaltransduktion 

wird zwischen Outside-in-Signaling und Inside-out-Signaling differenziert (Abb. 3). Beim 

Outside-in-Signaling kommt es zur Wechselwirkung zwischen Ligand und Rezeptor, wobei 

der Rezeptor in die aktive Konformation übergeht und ein Signal in das Zellinnere 

übermittelt. Durch das Outside-in-Signaling wird eine Serie intrazellulärer Ereignisse 

induziert, die eine Hydrolyse von Membranlipiden und die Aktivierung intrazellulärer 

Proteinkinasen nach sich zieht (Du, 1997). Aufgrund der Ligandenbindung kommt es bei 

Tyrosinkinasen zur Phosphorylierung (Ferrell, 1989). Mechanische Kräfte, die auf die 

Integrine wirken, wie bei der Adhäsion oder der Migration, verstärken diesen Effekt (Alon, 

2007). 1996 konnten Law et al. zeigen, dass auch die zytoplasmatische Domäne der β3-

Untereinheit nach Aktivierung an ihren Tyrosinrest phosphoryliert wird. Beim Inside-out-
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Signaling dagegen führt ein Signal aus dem Zellinneren zu einer Konformationsänderung und 

somit zu einer Aktivierung des Integrins (Shattil, 2004). Das Agonisten-induzierte Inside-out-

Signaling des αIIbβ3-Integrins wird als genereller Thrombozyten-Aktivierungssignalweg 

angesehen und ist für die primäre Hämostase und die Thrombusbildung obligatorisch (Varga-

Szabo, 2008). 

Abbildung 3: Schematische Darstellung des Inside-out- und Outside-in-Signaling
Zu erkennen ist das Zusammenspiel zwischen dem Zytoskelett und dem αIIbβ3-Integrin sowie dessen Liganden. 
Signalwege können von mehreren Stimulantien induziert werden wie PMA, SAG, Mn2+ und immobilisiertes 
Fibrinogen. (Modifiziert nach SFB612-Antrag) 

1.2.4 αIIbβ3-Integrin wirkt auf die Src-Tyrosinkinase  

Die „sarcoma“(Src)-Tyrosinkinase ist an der Signaltransduktion vieler biologischer Systeme 

beteiligt. Sie spielt zum Beispiel eine entscheidende Rolle in der Tumorentwicklung. Bindet 

ein Ligand am Integrin, so wird das intrazelluläre, ubiquitär exprimierte Protein Src aktiviert, 

was infolgedessen die Integrin-Zytoskelett-Interaktion vermittelt (Felsenfeld, 1999).

Der Src-Aktivierungszustand ist abhängig vom Phosphorylierungszustand seines 

Tyrosinrestes. Es gibt zwei kritische Phosphorylierungsstellen der Src-Tyrosinreste, 

Tyrosinrest 418 und Tyrosinrest 529 (Abb. 4). Der stimulierende Tyrosinrest (Y418) ist in der 

katalytischen Domäne lokalisiert und zur Autophosphorylierung fähig. Die volle katalytische 

Aktivität der Src-Kinase erfordert die Phosphorylierung des aktivierenden Tyrosinrests 

(Y418).  Der inhibitorische Tyrosinrest (Y529) ist in der Nähe des C-Terminus lokalisiert und 

fungiert als ein negativer Regulator, der die Src-Tyrosinkinase in der inaktiven Form hält. 

Nach der Dephosphorylierung des Tyrosinrests (Y529) kann der Tyrosinrest (Y418) 

phosphoryliert  und die Src-Tyrosinkinase aktiviert werden. 

  Inside-out-Signaling 
  induziert durch PMA, SAG

Ligand

αIIbβ3 

Zytoskelett

Outside-in-Signaling
induziert durch Fgimmob, Mn2+
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Abbildung 4: Schematische Darstellung der Src-Tyrosinkinase
Die Src-Tyrosinkinase wird N-Terminal an die Plasmamembran gebunden. Durch die Phosphorylierung des 
inhibitorischen Tyrosinrests (Y529) kommt es zu einer geschlossenen, inaktiven Konformation. Die 
Dephosphorylierung des inhibitorischen Tyrosinrests (Y529) und Phosphorylierung des aktivierenden 
Tyrosinrests (Y418) führt zu einer aktiven, geöffneten Konformation. (modifiziert nach Vielreicher, 2007) 

1.2.5 αIIbβ3-Integrin und dessen Leu33Pro-Varianten 

αIIbβ3-Integrin ist polymorph, wobei die polymorphen Varianten unterschiedliche Aktivitäten 

aufweisen. Die Erforschung dieser Varianten ist deshalb von großem Interesse. Ein 

entscheidender Fortschritt wurde 1989 durch die modifizierte PCR-Technologie von Newman 

und Mitarbeitern erzielt. Mithilfe dieser Technik konnte man den Basenaustausch auf der β3-

cDNA entdecken, der mit der phänotypischen Ausprägung des thrombozytären 

Alloantigensystems Human Platelet Antigen 1a/b (HPA-1a/b) korreliert (Newman, 1989). 

Eine der am häufigsten untersuchten Varianten ist der Leucin-zu-Prolin-Austausch an 

Position 33 der β3-Untereinheit des αIIbβ3-Integrins, der in der PSI-Domäne lokalisiert ist und 

eine Strukturveränderung des Rezeptors bewirkt (Yee, 2004). Die „unkritische“ Variante 

(HPA-1a) enthält an der Aminosäure 33 ein Leucin, wogegen die „kritische“ Variante (HPA-

1b) ein Prolin aufweist. 25 % der nordeuropäischen Population sind für dieses HPA-1b-Allel 

heterozygot und weitere 2 % homozygot (von dem Bome, 1990). Es wird vermutet, dass 

HPA-1b zu mehr Stabilität der offenen Konformation führt und damit die Signalweiterleitung 

vom Zelläußeren ins Zellinnere fördert. Thrombozyten, die HPA-1b exprimieren, weisen eine 

erhöhte Affinität für Fibrinogen auf, aggregieren schneller und zeigen verstärkte Migration, 

Ausbreitung sowie ein verstärktes Outside-in-Signaling (Vijayan, 2000). Daher ist es sinnvoll, 

die Mechanismen dieser gesteigerten Thrombozytenaktivität zu verstehen und in Verbindung 

mit intra- und extrazellulären Signalkaskaden zu bringen. Nur so können Ansatzpunkte für 

Therapeutika gefunden werden, mit denen ein erhöhtes Thromboserisiko gesenkt werden 

kann. 
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1.3 Liganden 

Liganden spielen eine zentrale Rolle bei der Adhäsion von Zellen. Neben extrazellulären 

Matrixproteinen (z. B. Kollagen) und Membranproteinen (z. B. VCAM) sind auch 

Serumproteine (z. B. Fibrinogen) Integrinliganden. In der Regel erkennen mehrere Liganden 

ein Integrin (Hynes, 1992). Die Bindung der Liganden erfolgt in Abhängigkeit von divalenten 

Kationen in der N-terminalen Domäne beider Untereinheiten. Für die Hämostase ist der 

αIIbβ3-Ligand Fibrinogen von besonderem Interesse. Fibrinogen ist aus zwei miteinander 

verbundenen identischen Untereinheiten (Homodimere) aufgebaut. Diese setzen sich 

ihrerseits aus drei miteinander verbundenen Einzelketten (α-, β- und γ-Kette) zusammen 

(Löffler, 1997). Dabei binden C-terminal die γ- und α-Kette über die drei charakteristischen 

N-terminalen Aminosäuresequenzen RGD, KGD und KQAGDV an αIIbβ3-Integrin 

(Cierniewski, 1999). Die Konformation des Fibrinogens spielt bei der Bindung an αIIbβ3-

Integrin eine entscheidende Rolle, da immobilisiertes Fibrinogen sowohl an den aktivierten 

als auch an den ruhenden αIIbβ3-Integrin gebunden werden kann, während lösliches 

Fibrinogen nur an den aktivierten Rezeptor bindet (Coller, 1986).  

1.4 Dysfunktionales αIIbβ3-Integrin 

Im Jahre 1918 entdeckte der Schweizer Arzt Eduard Glanzmann eine Bluterkrankheit, die 

autosomal rezessiv vererbt wird und bei der die Thrombozyten nicht aktiviert werden können. 

Die nach dem Mediziner benannte Glanzmann Thrombasthenie trug erheblich zur Aufklärung 

der Rolle des αIIbβ3-Integrins bei der Fibrinogenbindung bei (George, 1990). Die Patienten 

weisen eine verlängerte Blutungszeit und erhöhte Blutungstendenz der Schleimhäute, sowie 

Nasen- und Zahnfleischbluten auf (George, 1990). Dies beruht nicht auf einer erniedrigten 

Thrombozytenzahl sondern auf einer verminderten Aggregation bei Anwesenheit von 

stimulierenden Agonisten. Es konnte gezeigt werden, dass bei dieser Krankheit eine 

Veränderung des normalen Musters der Thrombozytenglykoproteine vorliegt (Nurden, 1974). 

Der Grad des αIIbβ3-Integrin-Defekts wird in drei Kategorien unterteilt: Bei Typ I fehlt das 

αIIbβ3-Integrin vollständig, bei Typ II liegt er zwischen 10-20 % und bei Typ III liegt er nur 

leicht reduziert (50-100 %), aber mit qualitativen Defekten vor (Caen, 1995). 27 genetische 

Defekte wurden bei der αIIb-Untereinheit und 23 bei der β3-Untereinheit nachgewiesen 

(Morel-Kopp, 1997; Grimaldi, 1998). Die genetischen Defekte beeinflussen das Pre-mRNA-

Spleißen, wodurch es zu instabilen mRNA-Transkripten oder zu anormalen Proteinprodukten 

kommt. Es konnte gezeigt werden, dass beide Untereinheiten essenziell sind, um eine 

effiziente Oberflächenexpression des αIIbβ3-Integrins zu gewährleisten (O´Toole, 1989). Beim 

Fehlen eines Polypeptids kommt es zur Instabilität und Degradation des anderen Polypeptids, 

da kein vollständiger Rezeptor gebildet werden kann.  
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1.5 Zielsetzungen 

Die HPA-1b-Variante der β3-Untereinheit des αIIbβ3-Integrins zeigt durch eine Verschiebung 

des Konformationsgleichgewichts des Rezeptors in Richtung der höher affinen, gestreckten 

Form eine gesteigerte Aktivierbarkeit und erhöhte Reaktivität der Thrombozyten. Dabei 

kommt es beim HPA-1b-Genotyp zur phenotypischen Ausrichtung einer erhöhten 

Thrombogenität (Vijayan, 2000; Loncar, 2007), welche sich durch eine erhöhte Inzidenz und 

verfrühtes Auftreten von Myokardinfarkten äußert (Zotz, 2005; Ghosh, 2002). 

Ziel der vorliegenden Arbeit ist es daher, beide Varianten des Rezeptors (HPA-1a und HPA-

1b) miteinander zu vergleichen und auf ihre Aktivierbarkeit hin zu analysieren. Es sollen 

mittels Fluoreszenz-Resonanzenergietransfers (FRET) die zytoplasmatische 

Konformationsänderung beziehungsweise der Abstand der Schenkel von α- und β-

Untereinheit an lebenden Zellen untersucht werden, wodurch Rückschlüsse auf die 

Rezeptoraktivierung gezogen werden können. Um die beiden Varianten des αIIbβ3-Integrins 

untersuchen zu können, wird ein heterologes Expressionssystem verwendet.  
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2 Material und Methoden      

2.1 Material 
2.1.1 Chemikalien und Enzyme 

Abciximab (Reopro, Lilly), Acrylamid/Bisacrylamid (National Diagnostics), Agarose 
(Biozym), Alfazyme (PAA), Ampicillin-Salz (Sigma), APS (Sigma), Ase I (Bio Labs), Bacto-
Trypton (BD), Bromphenolblau (Sigma), BSA (Sigma), DH5α-Zellen (Invitrogen), Difco 
Bacto Agar (BD), Dimethylsulfoxid (Sigma), DMEM-Medium (PAA), ECL-Western Blotting 
Detektionsreagenz (GE Healthcare), EDTA (Merck), Essigsäure (Merck), Ethidiumbromid 
(Inno-Train), F-12 Medium (Gibco), FCS (Gibco), Fibrinogen-human (Sigma), Fugene-HD-
Transfektionsreagenz (Roche), Gentamycin (Gibco), Geneticin (Invitrogen), Glycerin (Roth), 
1 Kb DNA-Leiter (Invitrogen), Magnesiumsulfat (Merck), Manganchlorid (Sigma), Methanol 
(Merck), Natriumcarbonat (Merck), Natriumchlorid (Merck), Natriumthiosulfat (Merck), 
Paraformaldehyd (Roth), PBS (Serag Wiessner), Pertussistoxin (Sigma), Phorbol-12-myristat-
13-acetat (Sigma),  Probenpuffer (Qiagen), Protein-Assay (Biorad), PVDF-Membran 
(Amersham Biosciences), PvuI (Bio Labs), ScrFI (Bio Labs), SDS (Biorad), Silbernitrat 
(Merck), 1-Stearoyl-2-arachidonoyl-sn-glycerol (Sigma), TEMED (Sigma), Titriplex III 
(Merck), Tris (Sigma), Trypanblau (Gibco), Tween20 (Merck), Yeast (BD). Alle 
Chemikalien, die nicht gesondert aufgeführt sind, wurden von den Firmen Sigma oder Merck 
bezogen. 

2.1.2 Stämme, Vektoren, Zelllinien und Liganden 

E. coli-Stamm: DH5α F- Φ80lacZ∆M15 ∆(lacZYA-argF)U169 recA1 endA1 
hsdR17(rk

-,  mk
+) phoA supE44 thi-1 gyrA96 relA1 λ- 

pcDNA3.1(+)  (Invitrogen) Expressionsvektor mit Zytomegalievirus(CMV)-
Promoter (Anhang) 

HEK 293 (CRL 1573)  humane embryonale Nierenepithelzelllinie, transformiert 
mit Adenovirus 5 

Fibrinogen   Alexa Fluor 647 human Fibrinogen (Molecular Probes) 

2.1.3 Primäre Antikörper 

Antikörper Spezies Hersteller 
Anti-GFP Rabbit (polyclonal) Genetex 
Anti-CD41 (PM6/248) Mouse (monoclonal) Biosource 
Anti-αIIb Rabbit (polyclonal) Santa Cruz 
Anti-β3 Goat (polyclonal) Santa Cruz 
Anti-Src (184Q20) Mouse (monoclonal) Invitrogen 
Anti-Src [pY418] Rabbit (polyclonal) Invitrogen 
Anti-Talin (8d4) Mouse (monoclonal) Sigma-Aldrich 
Anti-CD61-PE (SZ21) Mouse (monoclonal) Beckmann Coulter 
Anti-CD41-FITC Mouse (monoclonal) Beckmann Coulter 
Anti-γ1 (IgG1)-PE Mouse (monoclonal) Becton Dickinson 
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2.1.4 Sekundäre Antikörper 

Antikörper Spezies Hersteller 
Anti-Mouse IgG, HRP-gekoppelt Sheep (polyclonal) GE Healthcare 
Anti-Rabbit IgG, HRP-gekoppelt Donkey (polyclonal) GE Healthcare 
Anti-Goat IgG, HRP-gekoppelt Donkey (polyclonal) Santa Cruz 
Anti-Mouse IgG, PE-gekoppelt Goat (polyclonal) Genetex 

2.1.5 Oligonukleotide 

Integrin β3 human (221 bp)   5`Primer: GACTGTGCTGGCGCTGG 
     3`Primer: CACTCACTGGGAACTCGATGG 

2.1.6 Geräte, Kits und sonstiges Zubehör 

Anti-FITC Micro Beads (Miltenyi Biotec), CemiDoc-Geldokumentationssystem (Biorad), 
CO2-Feuchtbrutschrank (Heraeus), DNeasy-Kit (Qiagen), Durchflusszytometer-  
FACSCalibur (Becton Dickinson), ECL-Western-Blotting-Analysis-System (GE Healthcare), 
Elektrophoreseapparatur (Biorad), Elektrotransformationsapparatur (Biorad), Fluorimeter - 
Fluoroskan Acent (Thermo), Harvard-Pumpe (Harvard Apparatus),  Laser-Scanning-
Mikroskop - Axiovert 100M (Zeiss), Lichtmikroskop (Carl Zeiss), Photometer (Eppendorf), 
Plasmid Maxi Kit (Qiagen), Precision Plus Protein Standards (Biorad), Rainbow Calibration 
Particles (Becton Dickinson), Sterilwerkbank (Gelaire), Thermocycler (Biozym), 
Thermoschüttler (Eppendorf), UV-Transilluminator (Herolab), Wasserbad (Julabo), Western-
Blot-Gerätschaft (Biorad), Zentrifugen (Eppendorf/Hettich).  

2.1.7 Zusammensetzung der verschiedenen Medien 

 LB-Medium pH 7,5 Agar-Medium SOB-Medium 

Bacto-Trypton 10 g 10 g 20 g 

NaCl 10 g 10 g 0,5 g 

Yeast 5 g 5 g 5 g 

Mg SO4 - - 1 M

Difco Bacto Agar  - 15 g - 

Aqua bidest. ad 1Liter ad 1 Liter ad 1 Liter 

2.1.8 Gelrezepturen und Detergenzien für SDS-PAGE 

Substanz Sammelgel (3,9 %) Trenngel (8 %) 
30 % Acrylamid/ 

0,8 % Bisacrylamid 
1,3 ml 8 ml 

4 x Tris-HCl/SDS (pH 6,8) 2,5 ml --- 

4 x Tris-HCl/SDS (pH 8,8) --- 7,5 ml 

Aqua bidest. 6,1 ml 14,5 ml 

10 % APS 0,1 ml 0,2 ml 

TEMED 0,01 ml 0,02 ml 

Substanz 4 x Tris-HCl/SDS 
(pH 8,8) 

4 x Tris-HCl/SDS 
(pH 6,8) 

5 x Elektrophorese- 
puffer 

1 x Transfer- 
puffer 

Tris 91 g 6,05 g 30,3 g 3,03 g 
SDS 2 g 0,4 g 10 g --- 

Glycin --- --- 144 g 14,4 g 
Methanol --- --- --- 200 ml 

Aqua bidest ad 500 ml 100 ml 1000 ml 1000 ml 
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2.2 Methoden 

2.2.1 Umgang mit der HEK293-Zellmodelllinie 
2.2.1.1 HEK293-Zellen 

Bei den HEK293-Zellen handelt es sich um eine Zelllinie menschlicher embryonaler 

Nierenzellen (Human Embryonic Kidney; Abb. 5), die adhärent wachsen und leicht zu 

kultivieren sind (Graham, 1977). Die Zelllinie ist das Transformationsprodukt einer 

menschlichen embryonalen Nierenzelle mit menschlichem Adenovirus 5. 

Abbildung 5: Licht-mikroskopische Aufnahmen von HEK293-Zellen
Die HEK293-Zellen wurden bei 37 °C und 5 % CO2 kultiviert. A: Nach 6 Stunden sind die Zellen noch 
abgerundet und nicht adhärent. Balken: 20 μm; Aufnahme: 100 x /1,35 Öl-Objektiv. B: Nach 24 Stunden haben 
die Zellen eine zelltypische Morphologie eingenommen. Balken: 50 μm; Aufnahme: 40 x/1,30 Öl-Objektiv. 

2.2.1.2 Zellkultur der HEK293-Zellen 

Zellkultur bedeutet im Rahmen dieser Untersuchungen das Kultivieren von Zellen höherer 

eukaryotischer Lebewesen mit dem Ziel, diese Zellen unter einfachen Bedingungen außerhalb 

des intakten Organismus zu studieren.  

Alle Arbeiten im Zusammenhang mit der Kultivierung der HEK293-Zellen wurden unter 

einer Sterilwerkbank durchgeführt. Die Zellen wurden in einem CO2-Feuchtbrutschrank in 

wasserdampfgesättigter Atmosphäre mit 5 % Kohlendioxidgehalt bei 37 °C kultiviert. Das 

Zellkulturmedium bestand aus einer 1:1-Mischung aus DMEM- und F-12-Medium mit 10 % 

FCS und 100 μg/ml Gentamycin. Nach Erreichen von 70-80 % Konfluenz wurden die Zellen 

passagiert. Als Selektionsmarker für transfektierte Zellen diente Geneticin (G418), das dem 

Transfektanten mit einer Konzentration von 600 μg/ml zugegeben wurde.  

2.2.1.3 Passagieren von Zellen 

Bei Erreichen der Konfluenz von 70-80 % wurden die Zellen passagiert. Das Ablösen der 

Zellen geschah mithilfe des Enzyms Alfazyme. Dazu wurde das Medium abgesaugt und die 

Zellen zweimal mit PBS gewaschen. Nach dem Absaugen des PBS wurden die Zellen 

acht Minuten mit Alfazyme bei 37 °C bis zur Abrundung der Zellen inkubiert. Das Ablösen 

BA 
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der Zellen wurde durch Zugabe von FCS-haltigem Medium gestoppt, danach wurden die 

Zellen in Röhrchen aufgenommen und zentrifugiert (300 g, 4 °C, 7 min). Das Zellpellet 

wurde in 1 ml PBS gelöst und die Zellzahl mithilfe der Neubauerkammer bestimmt. 

  

2.2.1.4 Zellzahlbestimmung 

Das Wachstum der Zellen ist unter anderem abhängig von der ausgesetzten Zellzahl. Daher 

sollte die Zellzahl bestimmt werden. Die einfachste Methode dafür ist die Auszählung unter 

dem Lichtmikroskop mittels einer Neubauerkammer. Zur Bestimmung der Lebendzellzahl 

werden die Zellen mit Trypanblau behandelt. Trypanblau ist ein saurer Farbstoff, der sich an 

Proteine anlagern kann und selektiv in Zellen mit geschädigter Zellmembran eindringt.  

Die Zellen wurden im Verhältnis von 1:1 mit Trypanblau-Lösung verdünnt und dann in einer 

Neubauerkammer unter dem Lichtmikroskop ausgezählt. Bei einer Auszählung aller vier 

großen Felder (62 Kästchen) ergab sich folgende Beziehung. 

GZ = Gesamtzellzahl 
EZ = ermittelte Zellzahl (in 4 großen Quadraten)  

 GZ= (EZ / 4) x A x 104 x V  A   = Verdünnungsfaktor
       V   = Gesamtvolumen in ml 

2.2.1.5 Kryokonservierung der Zellen 

Langzeitversuche machen es unerlässlich, Zellen zu konservieren, damit auf Reserven 

zurückgegriffen werden kann.  

Die in dieser Arbeit verwendeten Zellen wurden für einen längeren Zeitraum bei -196 °C in 

flüssigem Stickstoff kryokonserviert. Dabei wurden die Zellen von der Zellkulturschale 

abgelöst, in PBS aufgenommen und zentrifugiert (300 g, 4 °C, 7 min). Die Ausgangszellzahl 

betrug 1 x 106. Die einzufrierenden Zellen wurden zunächst in 4 °C kaltem, 80%igem FCS 

(80 % FCS + 20 % DMEM) aufgenommen, nach Zugabe von 10%igem Dimethylsulfoxid 

(DMSO) (10 % DMSO + 90 % DMEM) zügig resuspendiert und in einem Kryo-Röhrchen bei 

-196 °C eingefroren.  

2.2.1.6 Auftauen und Revitalisierung von Zellen 

Die eingefrorenen Kryo-Röhrchen wurden dem flüssigen Stickstoff entnommen und zügig in 

einem Wasserbad bei 37 °C aufgetaut. Sobald nur noch ein kleiner Eiskristall zu sehen war, 

wurde die Zellsuspension rasch in 2 ml kaltes 50%iges FCS überführt. Die Zellsuspension 

wurde zentrifugiert (300 g, 4 °C, 7 min). Der DMSO-haltige Überstand wurde abgenommen, 

danach konnte das Pellet im Zellkulturmedium aufgenommen und zur weiteren Kultivierung 
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verwendet werden. Am nächsten Tag wurde das Medium gewechselt, um das restliche 

DMSO, tote Zellen und zelluläre Bestandteile zu entfernen. 

2.3 Präparation von Plasmid-DNA 
2.3.1 Plasmide 

Eine genaue Karte des verwendeten Plasmids ist im Anhang zu finden. In Tabelle 1 werden 

die Bestandteile der einzelnen Plasmide aufgeführt. Durch Kombination der Plasmide können 

Doppeltransfektanten hergestellt werden. Die HEK293-Zellen können beide Varianten des 

αIIbβ3-Integrins (Leu33Pro) exprimieren. 

Name Vektor Integrin-Untereinheit Fluorophor Promoter Größe Größe des 
 Fusionsproteins 

P71 
pcDNA3.1(-) 
(Invitrogen) 

--- --- CMV-Promoter 5,4 kb --- 

P92 
pcDNA3.1(-) 
(Invitrogen) 

β3 (HPA-1a, Leu33) YFP CMV-Promoter 7,1 kb 132 kDa 

P96 
pcDNA3.1(-) 
(Invitrogen) 

β3 (HPA-1b, Pro33) YFP CMV-Promoter 7,1 kb  132 kDa 

P101 
pcDNA3.1(-) 
(Invitrogen) 

αIIb  CFP CMV-Promoter 7,9 kb 167 kDa 

Tabelle 1: Auflistung der verwendeten Plasmide und ihrer wichtigsten Eigenschaften
CFP: Cyan Fluorescent Protein (blau); YFP: Yellow Fluorescent Protein (gelb). 

2.3.2 Transformation 

Um das Rezeptor-Gen unter Kontrolle eines konstitutiven Promoters in Säugerzellen 

einzuschleusen, wurden verschiedene Plasmide eingesetzt (Tabelle 1). Die Plasmide besitzen 

für die Vermehrung und Selektion in Escherichia coli (kompetente Zellen) einen bakteriellen 

Replikationsursprung (ori) und einen Selektionsmarker, der die unter Kontrolle eines 

bakteriellen Promoters stehende Antibiotikaresistenz gegen Neomycin (NeoR) und Ampicillin 

(AmpR) kodiert. Die Plasmide besitzen außerdem eine so genannte Multiple Cloning Site 

(MCS), die mehrere Schnittstellen für Restriktionsendonukleasen enthält, sodass fremde DNA 

eingefügt werden kann. 

Für die Transformation selbst wurden hoch kompetente DH5α-Zellen (E.coli) verwendet. LB-

Medium und Agar-Medium wurden autoklaviert und nach dem Abkühlen mit Antibiotikum 

(100 μg/ml Ampicillin) versetzt. Zur Plasmidvervielfältigung wurden die kompetenten Zellen 

mit Plasmid-DNA transformiert und unter Selektionsdruck kultiviert. Dazu wurden die 

kompetenten Zellen auf Eis aufgetaut und 100 μl kompetente Zellen in 15-ml-Röhrchen, 

welche auf Eis gekühlt wurden, gegeben. Zu den kompetenten Zellen wurden 4 ng Plasmid-

DNA hinzupipettiert. Als Negativkontrolle diente ein 15-ml-Röhrchen mit kompetenten 

Zellen ohne DNA und als Kompetenzkontrolle diente ein drittes 15-ml-Röhrchen mit dem 

pUC-Plasmid in einer Konzentration von 50 pg/μl. Die drei 15-ml-Röhrchen wurden 

30 Minuten auf Eis inkubiert, anschließend erfolgt ein Hitzeschock für 45 Sekunden in einem 
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42-°C-Wasserbad. Nach dem Hitzeschock wurden die Röhrchen erneut auf Eis gegeben. Zu 

den Röhrchen wurden jeweils 900 μl SOB-Medium zugegeben. Die drei Ansätze inkubierten 

dann 60 Minuten bei 37 °C unter Schütteln und wurden anschließend 5 Minuten bei 5.000 

rpm zentrifugiert. Der Überstand wurde verworfen, das Pellet resuspendiert und auf 

entsprechende Agarplatten ausplattiert. Die Agarplatten wurden über Nacht invers im 

Inkubator bei 37 °C inkubiert. Am nächsten Tag wurden die entstandenen Kolonien gezählt.  

2.3.3 Restriktionsendonukleasenverdau 

Die Restriktionsenzyme wurden nach Protokoll des Herstellers (Bio Labs) mit den jeweiligen 

Puffern eingesetzt. Die Plasmid-DNA wurde aus den Maxipräparationen nach Qiagen  

gewonnen, die DNA-Konzentration anschließend photometrisch bestimmt und qualitativ 

anhand einer Gelelektrophorese nachgewiesen. Die Restriktion der Plasmid-DNA wurde nach 

Tabelle 2 zusammengesetzt und je nach Enzym bei Raumtemperatur (RT) oder bei 37 °C über 

Nacht inkubiert. Anschließend wurde 1 μg Plasmid-DNA auf das Agarosegel aufgetragen und 

aufgetrennt. Die Plasmid-DNA wurde über eine UV-Lampe qualitativ beurteilt und je nach 

Ergebnis weiter für die Transfektion verwendet. 

Aqua bidest. ad. 20 μl 
10 x Puffer 2 μl 
Acetyliertes BSA (10 μg/μl) 1 μg 
DNA 1 μg 
Restriktionsenzym (20.000 U/ml) 1 μl 

Tabelle 2: Ansatz des Restriktionsverdaus 

2.3.4 Agarose-Gelelektrophorese 

Die Gelelektrophorese ist eine analytische Methode, um Nukleinsäuren nach ihrer Größe zu 

trennen und diese durch Vergleich mit Nukleinsäure-Stücken bekannter Größe zu 

identifizieren. Dazu wurde 1 % (w/v) Agarose durch Erhitzen in 0,5 x Tris-Acetat-EDTA-

(TAE)-Puffer (40 mM Tris-HCl, pH 8,0; 40 mM Essigsäure; 1 mM EDTA, pH 8,0) gelöst. 

Der warmen Agarose-Lösung wurde 0,1 μg/ml Ethidiumbromid zugegeben. Die 

Nukleinsäure-Proben (1 μg) wurden mit 1/5 Volumen Probenpuffer gemischt und in die 

Taschen aufgetragen. Unter dem Einfluss eines elektrischen Felds wanderten die Moleküle 

durch das Gel. Qualität und Länge der Nukleinsäuren wurden nach der Elektrophorese im 

CemiDoc-Geldokumentationssystem über UV-Licht kontrolliert und dokumentiert.  
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2.3.5 Plasmidreinigung 

Nach Transformation der DH5α-Zellen mit den Plasmiden wurden Maxipräparationen 

hergestellt. Die Maxipräparation wurde nach Protokoll des Herstellers (Qiagen) durchgeführt. 

Die DNA wurde in 50 μl TE-Puffer gelöst und bei -20 °C aufbewahrt.

2.3.6 DNA-Konzentrationsbestimmung 

Die Konzentration der Plasmid-DNA wurde mit einem optischen Verfahren bestimmt. Es 

wurde die optische Dichte (OD) des Plasmids in einer 1:50 Verdünnung in TE-Puffer bei 260 

nm gemessen, da die DNA ihr Absorptionsmaximum bei dieser Wellenlänge hat. Man geht 

davon aus, dass 1 OD260nm 50 μg/ml DNA entspricht. Proben, die einen OD260nm/OD280nm-

Quotienten (R½) von > 1,8 aufwiesen, wurden für die weiteren Experimente verwendet. 

2.4 Funktionale Integrität beider HPA-1-Rezeptorvarianten 
2.4.1 Transfektion 

Bei der Transfektion handelt es sich um das Einbringen von Fremd-DNA in eukaryotische 

Zellen. Unterschieden wird zwischen dem temporären Einbringen des Plasmids in die Zelle 

(transiente Transfektion) und dem ständigen Einbau in das Genom (stabile Transfektion). Für 

die stabile Transfektion wurde linearisierte Plasmid-DNA mit FUGENE-HD-

Transfektionsreagenz versetzt. 

Die HEK293-Zellen wurden in 24 Well-Platten ausgesät, sodass sie zur Transfektion 70-80 % 

konfluent waren. Für die Transfektion wurden 2 μg Plasmid-DNA in 100 μl DMEM-Medium 

und 6 μl FUGENE-HD-Transfektionsreagenz zusammengegeben und 15 Minuten bei RT 

inkubiert. Das Zellmedium wurde von den Zellen entfernt, die Zellen mit PBS gewaschen und 

anschließend 500 μl pro Well FCS-freies DMEM-Medium zugegeben. Nach Inkubation des 

Transfektionsgemisches wurden 25 μl pro Well zu den Zellen zugegeben und anschließend 

für 18-72 Stunden im Brutschrank inkubiert. Nach der Inkubationszeit wurden die 

transfektierten Zellen aufgenommen, zentrifugiert (300 g, 4 °C, 7 min) und in frischem 

Selektionsmedium (mit 600 μg/ml G418)  aufgenommen.

2.4.2 MACS-Aufreinigung 

Um die αIIbβ3-positiv transfektierten Zellen aus einer Zellsuspension zu isolieren, wurde das 

„Magnetic-Activated Cell Sorting“ (MACS)-System verwendet. Dabei wird die 

Zellsuspension, in der sich die zu isolierenden Zellen befinden, mit Magnet-Beads inkubiert. 

Diese Magnet-Beads sind an Antikörper gebunden, die spezifische Strukturen auf der 

Oberfläche der zu isolierenden Zellen erkennen.  
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Das Zellkulturmedium wurde abgenommen, die Zellen in PBS aufgenommen und 

zentrifugiert (300 g, 4 °C, 7 min). Die Konzentration des Zellpellets von maximal 5x107

Zellen in 100 μl PBS wurde resuspendiert. Es folgte die Zugabe von 10 μl FITC-markiertem 

αIIbβ3-Integrin-spezifischen CD41-Antikörper und eine Inkubation von 10 Minuten bei 4 °C 

im Dunkeln. Nach der Inkubation wurden die Zellen mit 2 ml PBS gewaschen (300 g, 4 °C, 7 

min), der Überstand verworfen und in 90 μl PBS aufgenommen. Anschließend wurden die 

Zellen mit 10 μl Magnet-Beads, die gegen die FITC-Markierung des Primärantikörpers 

gerichtet waren, versetzt und die Lösung für 15 Minuten bei 4 °C inkubiert. Erneut wurden 2 

ml PBS zugegeben, die Lösung gewaschen (300 g, 4 °C, 7 min) und in 500 μl PBS resuspen-

diert. Zur Separation der Zellen wurden die LS-Säulen in einer Magnetvorrichtung befestigt 

und mit 2 ml PBS äquilibriert. Die resuspendierte Zelllösung wurde auf die Säule gegeben 

und mit PBS mehrfach gewaschen. Zur Gewinnung der αIIbβ3-transfektierten HEK293-Zellen 

wurde die Säule vom Magnet entfernt, mit 500 μl PBS versetzt und das Eluat anschließend 

mithilfe eines Stempels gewonnen. 

2.4.3 Expression der transfektierten HEK293-Zellen 

Das aus der MACS-Aufreinigung gewonnene Zelleluat wurde gut resuspendiert. Die Zellzahl 

wurde mit der Neubauerkammer bestimmt und anschließend so verdünnt, dass sich in 100 μl 

Zellkulturmedium lediglich eine Zelle befand. Jeweils 100 μl der Zellkultursuspension 

wurden pro Well einer 96-Well-Platte zugegeben. Nach einigen Tagen wurde mikroskopisch 

kontrolliert, ob einzelne Kolonien vorhanden waren, und nur solche Wells weiter kultiviert, 

die lediglich einen Zellklon aufwiesen. Die gesuchten Einzelklone wurden in der 

Durchflusszytometrie mit dem αIIbβ3-Integrin-spezifischen Antikörper (Anti-CD41) bestätigt. 

2.4.4 Durchflusszytometrie 

Die Durchflusszytometrie ist ein Verfahren zur quantitativen und qualitativen Bestimmung 

physikalischer und molekularer Eigenschaften von Zellen oder Partikeln (z. B. 

Polystyrolkugeln) in einem laminaren Flüssigkeitsstrom, welche einen Laserstrahl einzeln 

passieren. Das dabei zerstreute Licht wird mithilfe verschiedener Detektoren analysiert. 

In den hier durchgeführten Experimenten wurden die HEK293-Zellen auf die αIIbβ3-Integrin-

Expression und deren Aktivierung untersucht. Die Detektion des Rezeptors erfolgte über R-

Phycoerythrin(PE)-fluoreszenzmarkierte Antikörper. Die Analyse der Rezeptoren hinsichtlich 

ihrer Aktivierbarkeit geschah mit Alexa-647-Fluoreszenz-markiertem Fibrinogen. 

Vorbereitend wurden die Zellen von den Petrischalen abgelöst und mit PBS gewaschen 

(300 g, 4 °C, 7 min). Der Überstand wurde dekantiert, das Pellet in 200 μl PBS aufgenommen 
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und die Zellzahl bestimmt. Es folgte die Resuspendierung der Zellen (8x105) in 50 μl PBS 

sowie die Inkubation mit den jeweiligen spezifischen Antikörpern (Anti-CD41; Anti-CD61-

PE). Die Inkubation erfolgte für 30 Minuten bei RT im Dunkeln. Zur Erfassung der 

unspezifischen Bindung wurde eine Zellprobe mit PE-markierter Isotypkontrolle mitgeführt. 

Die Inkubation mit Alexa-647-gekoppeltem Fibrinogen erfolgte ebenfalls für 30 min bei RT, 

abgedunkelt. Da der CD41-Primärantikörper unmarkiert ist, wurden die Zellen nach der 

Primärantikörper-Inkubation mit PBS gewaschen (300 g, 4 °C, 7 min), das Pellet in 50 μl 

resuspendiert und für 30 Minuten bei RT im Dunkeln mit 1 μl PE-markiertem 

Sekundärantikörper inkubiert. Nach abgeschlossener Inkubation wurden alle Ansätze mit PBS 

gewaschen (300 g, 4 °C, 7 min), die Zellen in 500 μl PBS resuspendiert und im 

Durchflusszytometer analysiert.  Für die Aktivierungsversuche wurden die Zellen entweder 

für 20 min bei 37 °C mit 30 nM 1-Stearoyl-2-arachidonoyl-sn-glycerol (SAG) oder unter den 

gleichen Bedingungen mit 1 μM Phorbol-12-myristat-13-acetat (PMA) inkubiert. Nach der 

Aktivierung wurden die Zellen mit PBS gewaschen, fixiert (2 % Paraformaldehyd) und mit 

den entsprechenden Antikörpern behandelt. Als Negativkontrolle wurden nicht aktivierte 

Zellen durchflusszytometrisch untersucht sowie einige Zellen vor der Aktivierung mit 

Abciximab (blockiert αIIbβ3-Integrin) oder Pertussistoxin (blockiert G-Protein-gekoppelte 

Rezeptoren) inkubiert. Zur Berechnung der Rezeptorzellzahl wurden Rainbow-

Kalibrationspartikel bei gleicher Geräteeinstellung gemessen. Mit den Rainbow-Partikeln 

können maximal acht Meanwerte einer definierten Anzahl von PE-Molekülen zugeordnet und 

jeweils eine Ausgleichsgerade berechnet werden. Der ermittelte PE-Meanwert der Probe kann 

anhand der Geradengleichung als Fluoreszenz-Äquivalente wiedergegeben werden. Über die 

Fluoreszenz-Äquivalente und die PE-Ratio (PE-Ratio von Anti-Mouse IgG PE beträgt 2,8) 

konnte die Rezeptorzahl pro Zelle berechnet werden. Die PE-Ratio ist der Quotient OD 

566 nm/OD 280 nm. OD 566 nm bezieht sich dabei auf das Konjugat R-Phycoerythrin und 

die OD 280 nm entspricht dem generellen Proteingehalt. 

2.5 Nachweis der richtigen Klone 
2.5.1 Isolierung und Konzentrationsbestimmung der DNA 

Zur Isolierung der DNA aus den Zellen wurde das DNeasy Mini Kit nach Protokoll des 

Herstellers (Qiagen) verwendet. Die DNA-Konzentration wurde mit dem Photometer 

bestimmt, gebrauchsfertig aliquotiert und bei -20 °C gelagert. 
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2.5.2 Polymerase Chain Reaction (PCR) 

Die PCR stellt eine Technik zur Vermehrung eines spezifischen Genomfragments mit 

bekannter Nukleotidsequenz dar (Mullis, 1986).  

Die aus den Zellen gewonnene DNA wurde über die im Thermocycler stattfindende PCR 

vervielfältigt. Die Primer wurden für eine Annealing-Temperatur von 60 °C designed. Die in 

diesem Fall verwendete Taq-Polymerase hat eine optimale Arbeitstemperatur von 72 °C, die 

zu amplifizierenden DNA-Fragmente haben eine Länge von 221 bp. Die Schritte 

Denaturierung, Primerhybridisierung und Elongation wurden in der Regel 35 mal 

durchgeführt. Das PCR-Produkt kann in der Gelelektrophorese anhand seiner Größe 

identifiziert werden. Die PCR wurde nach Angaben des Herstellers (Qiagen) durchgeführt. 

2.5.3 Oligonukleotide 

Die Oligonukleotide wurde mithilfe des Programms „Multiple Alignment Construction & 

Analysis Workbench“ (MACAW) designed. Die Primer (Integrin β3 human) wurden von der 

Firma MWG synthetisiert. Die Lyophilisate wurden mit dest. Wasser gelöst und in einer 

Stocklösung von 100 pmol bei -20 °C eingefroren.  

2.5.4 Restriction Fragment Length Polymorphism (RFLP) 

RFLP bezeichnet Unterschiede von DNA-Sequenzen homologer Chromosomen, welche als 

verschiedene Restriktionsfragmentmuster im Gel sichtbar gemacht werden.  

Die PCR-Produkte wurden mit einer spezifischen Restriktionsendonuklease (SrcFI) über 

Nacht nach Herstellerangaben (Bio Labs) verdaut. Die verdauten PCR-Produkte wurden in 

einem 12%igen Polyacrylamidgel entsprechend ihrem Molekulargewicht aufgetrennt und 

über die Silberfärbung nach Bassam dargestellt (Bassam, 2007). 

2.6 Nachweis der Proteinexpression 
2.6.1 Proteinbestimmung 

Die Proteinkonzentrationen wurden mithilfe des Biorad-Protein-Assays mit BSA als Standard 

photometrisch bestimmt. In Küvetten wurden sechs Verdünnungen vom BSA- 

Standard mit einer Konzentration von 0,1 mg/ml bis zu 1,5 mg/ml zur Erstellung einer 

Kalibrierkurve gemessen. 8 μl des Standards sowie 400 μl des 1:5 verdünnten Biorad-Protein-

Assays wurden gemischt und im Photometer bei 750 nm bestimmt. Anschließend wurden die 

Proben gemessen und die Proteinkonzentration mithilfe der Eichkurve ermittelt. 
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2.6.2 SDS-PAGE 

Die diskontinuierliche SDS-PAGE (Sodium Dodecyl Sulfate Polyacrylamide Gel 

Elektrophoresis) ist eine Methode zur Auftrennung denaturierter Proteine entsprechend ihrem 

Molekulargewicht (Laemmli, 1970). Den Proteinen wird SDS im Überschuss zugegeben und 

diese dann 5 Minuten bei 95 °C thermisch denaturiert. Das Gel wird mit 25 μg Gesamtprotein 

beladen. Die gelelektrophoretische Auftrennung erfolgte bei 150 Volt während eines 

Zeitraumes von 90 Minuten. Anschließend erfolgte die Western-Blot-Analyse. 

2.6.3 Western-Blot-Analysen 

Die in der SDS-PAGE aufgetrennten Proteingemische wurden über ein senkrecht zum Gel 

angelegtes elektrisches Feld auf eine Polyvinylidenfluorid (PVDF)-Membran transferiert 

(Towbin, 1979). Die Proteine bleiben aufgrund von hydrophoben Wechselwirkungen an der 

Membranoberfläche haften.  

Nach dem Transfer der Proteine wurden die freien Bindungsstellen auf der Membran mit 

einer 5%igen Trockenmilchpulverlösung blockiert. Anschließend wurden die primären 

Antikörper (Anti-GFP; Anti-β3; Anti-αIIb; Anti-Src; Anti-Src(pY418); Anti-Talin)  in einer 

5%igen Trockenmilchpulverlösung gegen die zu untersuchenden Proteine zugegeben und 

mindestens eine Stunde unter ständigem Schütteln bei RT inkubiert (Burnette, 1981). Die 

unspezifisch gebundenen Antikörper wurden durch mehrere Waschschritte mit 

detergenzhaltigem Puffer (PBS + 1 % Tween20) entfernt. Um die spezifische Bindung der 

Antikörper an die Epitope des Antigens nachzuweisen, wurde die Membran mit einem 

sekundären Antikörper (Anti-Mouse IgG; Anti-Rabbit IgG; Anti-Goat IgG) in einer 5%igen 

Trockenmilchpulverlösung eine Stunde bei RT inkubiert. Dieser ist an „Horse Radish 

Peroxidase“ (HRP) gekoppelt und gegen den Primärantikörper gerichtet. Nach Inkubation mit 

dem Sekundärantikörper folgen drei weitere Waschschritte. Auf die Membran wurde eine 

Substratlösung zugegeben und diese 5 Minuten inkubiert. Durch die an den 

Sekundärantikörper gebundene HRP wurde die Substratlösung umgesetzt und eine licht-

emittierende Reaktion hervorgerufen. Als Substrat wurde das ECL-Western-Blotting-

Analysis-System verwendet. Die Produkte bildeten ein fluoreszierendes Spaltprodukt um den 

Antigen-Antikörper-Komplex, welches mit dem ChemiDoc XRS detektiert werden konnte. 
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2.7 Funktionelle Untersuchungen zur HPA-1-Rezeptoraktivierung 
2.7.1 FRET-Analysen 

Fluoreszenz-Resonanzenergietransfer (FRET) ist ein physikalischer Prozess, bei dem 

Photonenenergie eines angeregten Fluoreszenzfarbstoffs (Donor-Fluorophor) strahlungsfrei 

über Dipol-Dipol-Wechselwirkung auf einen zweiten, sich in der Nähe befindlichen 

Fluoreszenzfarbstoff (Akzeptor-Fluorophor) kontaktfrei transferiert wird (Heim, 1996; 

Pollok, 1999). Anschließend können zwei Emissionswellenlängen wahrgenommen werden: 

die des Donors und die des Akzeptors. FRET wurde für die Analyse von Protein-Protein-

Interaktionen eingesetzt, um den Aktivierungszustand des αIIbβ3-Integrins in Abhängigkeit 

von Konformationen der Rezeptoruntereinheiten zu analysieren.  

Das CFP (Cyan Fluorescent Protein) hat ein Absorptionsspektrum von 380-475 nm und ein 

Emissionsspektrum von 470-530 nm. Das Absorptionsspektrum von YFP (Yellow 

Fluorescent Protein) liegt bei 470-515 nm und das Emissionsspektrum bei 520-600 nm. 

Mit dieser Methode können Abstände zwischen den beiden Fluorophoren gemessen werden. 

Beträgt dieser Abstand mehr als 10 nm, so ist kein FRET-Signal nach Anregung des Donors 

zu detektieren (Abb. 6 A). Befinden sich die Fluorophore näher als 10 nm, kann ein 

Energietransfer vom Donor (CFP) auf den Akzeptor (YFP) stattfinden, worauf Donor wie 

auch Akzeptor fluoreszieren (Abb. 6 B). Wird jedoch der Akzeptor mit einem Laser bei 514 nm 

temporär inaktiviert, so kann dieser keine Energie mehr vom Donor aufnehmen (Abb. 6 C), 

wodurch die Emissions-Intensität des Donors wieder auf das Niveau von Abb. 6 A steigt. 

Die α-Untereinheit ist C-terminal mit einem Donorfluorophor und die β-Untereinheit mit 

einem Akzeptorfluorophor versehen. Die FRET-Effizienz korreliert mit dem Abstand der 

beiden Fluorophore zueinander. Je geringer der Abstand, desto höher die FRET-Effizienz. 

Die HEK293-Zellen wurden mit αIIb-CFP und β3-YFP stabil doppeltransfektiert und mit 

einem Argon-Laser bei 458 nm angeregt. Die Wellenlänge wurde so gewählt, dass sie den 

Donor anregt. Da jedoch die Anregungswellenlänge des Donors teilweise in den 

Anregungswellenlängenbereich des Akzeptors hineinreicht, könnte der Argon-Laser sowohl 

Donor als auch Akzeptor anregen. Dementsprechend musste ein Photomultiplier-Abgleich mit 

einer Reihe von Akzeptor-Einzeltransfektanten vorgenommen werden. Zum Abgleich der 

Zellen wurden die Akzeptor-Einzeltransfektanten mit einer Wellenlänge von 458 nm 

angeregt, die im Mikroskop sichtbare gelbe Fluoreszenz kompensiert und die Mikroskop-

Einstellung beibehalten, sodass bei den nachfolgenden FRET-Messungen nur die durch FRET 

entstandene zusätzliche Gelbfluoreszenz detektiert werden konnte. Des Weiteren ragte der 

Emissionsbereich des Donors in den des Akzeptors hinein, weshalb es zum so genannten 

Einbluten der blauen Emission in den gelben Kanal kommt (Wallrabe, 2005). 
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Dementsprechend ist auch ein Photomultiplier-Abgleich mit einer Reihe von Donor-

Einzeltransfektanten bei 488 nm notwendig. Es wurden Einzeltransfektanten ausgewählt, bei 

denen die Fluoreszenz-Intensitäten mit denen der Doppeltransfektanten vergleichbar sind. 

Nach dem Abgleich mit dem Akzeptor und dem Donor kann davon ausgegangen werden, dass 

die in den FRET-Analysen detektierten Fluoreszenzemissionen tatsächlich durch FRET 

hervorgerufen werden und nicht durch die Eigenfluoreszenz von CFP und YFP. Die FRET-

Analysen können in einem Fluoreszenzmikroskop oder Fluorimeter erfolgen. Für die FRET-

Analysen wurden Zellen verwendet, die in den Durchflusszytometrie-Untersuchungen gleiche 

Rezeptor-Expressionslevel  der HPA-1a- und HPA-1b-Varianten aufwiesen. 

Abbildung 6 : Interaktionen zwischen dem Fluorophorenpaar CFP und YFP bzw. αIIb und β3

A: Ist der Abstand zwischen Donor und Akzeptor größer 10 nm, überträgt der Donor keine Energie auf den 
Akzeptor. B: Liegt der Akzeptor in unmittelbare Nähe zum Donor (näher 10 nm), kommt es zum Energietransfer 
auf den Akzeptor, wobei die Emission des Akzeptors und die des Donors wahrgenommen wird. C: Beim 
Akzeptor-Bleaching ist der Akzeptor nicht mehr in der Lage, Energie vom Donor aufzunehmen, sodass lediglich 
die Emission des Donors wahrgenommen wird. (entnommen und modifiziert nach Nature 2005)

2.7.2 Basale FRET-Effizienz über Akzeptor-Bleaching

Die FRET-Analyse bedient sich des so genannten Akzeptor-Bleaching (Karpova, 2003). Der 

Akzeptor (YFP) wird mit einem Laser bei 514 nm temporär inaktiviert, sodass dieser keine 

Energie mehr vom Donor (CFP) aufnehmen kann. Durch das Unterbinden des 

Energietransfers nimmt die Fluoreszenzemission des Akzeptors ab und die des Donors 

entsprechend dem zuvor an den Akzeptor abgegebenen Energieanteil zu (Abb. 6 C).  
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Die mit αIIb-CFP/β3-YFP transfektierten und zu untersuchenden Zellen (HPA-1a und HPA-

1b) wurden isoliert, zentrifugiert (300 g, 4 °C, 7 min), in PBS aufgenommen und in der 

Neubauerkammer gezählt. Die Zellen wurden auf mit 1 % BSA beschichtete Objektträger 

gegeben und mit einem Deckgläschen versehen. Zusätzlich wurde bei einigen Zellen der 

αIIbβ3-Rezeptor aktiviert, indem die Zellen 20 Minuten mit 1 μM PMA stimuliert und auf mit 

Fibrinogen (50 μg/ml) beschichtete Objektträger gegeben wurden. Anschließend wurden die 

Zellen in einem konfokalen Laser-Scanning-Mikroskop mithilfe eines Argon-Lasers bei 514 

nm gebleicht und mittels der LSM-Software dokumentiert. Für die Anregung der Fluorophore 

wurde der Argonlaser bei 458 nm verwendet. Die Analyse und Quantifizierung der 

Aufnahmen erfolgte mit der von Rasband Wayne am National Institutes of Health (NIH) 

entwickelten Software „ImageJ 1.42q“. Es wurden Aufnahmen vor und nach dem Akzeptor-

Bleaching miteinander verglichen. Ein Aufnahmezyklus bestand aus vier deckungsgleichen 

Bildern (CFP vor und nach dem Bleichen  sowie YFP vor und nach dem Bleichen), die in 

Graustufen umgewandelt wurden. Die Intensitätsverteilung der Graustufen (0-255) wurde 

gemittelt und mit den anderen Bildern verglichen. Die detaillierte Auswertung befindet sich 

im Anhang.   

2.7.3 FRET-Analysen am Fluorimeter 

Um das αIIbβ3-Integrin-Adhäsionsverhalten zwischen HPA-1a und HPA-1b unter statischen 

Bedingungen zu untersuchen, wurden Adhäsionsversuche unter Inside-out- und Outside-in-

Bedingungen vorgenommen. Die Zellen wurden aus den Petrischalen isoliert, zentrifugiert 

(300 g, 4 °C, 7 min) und in einer Neubauerkammer gezählt. Die Zellen wurden in PBS 

verdünnt, sodass je Well 200 μl mit je 200.000 Zellen in einer 96-Well-Platte eingesetzt 

wurden. Die Zellen wurden auf immobilisiertem Fibrinogen (100 μg/ml) oder mit Mn2+

(0,5 mM) behandelt, um ein so genanntes Outside-in-Signaling zu induzieren. Zusätzlich 

wurden die Zellen mit PMA (1 μM) oder SAG (30 nM) behandelt und das Inside-out-

Signaling induziert. Zur Kontrolle wurden einige Zellen nicht behandelt. Die FRET-Analysen 

wurden am Fluorimeter gemessen. CFP wurde bei 430 nm und YFP bei 485 nm angeregt. Die 

Fluoreszenzemission von CFP wurde bei 485 nm und die von YFP bei 538 nm gemessen. Die 

FRET-Effizienz wurde durch Anregung des CFP und Messung der YFP-Emission ermittelt. 

Das FRET-Signal wurde quantifiziert, um den Effekt von Agonisten auf HPA-1a- und HPA-

1b-Varianten zu untersuchen. Über einen Zeitraum von vier Stunden wurden FRET-Signale 

analysiert. Nach der ersten Messung erfolgte die Zugabe der Agonisten. Die FRET-Signale 

wurden analysiert und die Veränderung der relativen FRET-Signale (Endpunkte) im 

Diagramm dargestellt. 
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2.7.4 FRET-Analysen am Mikroskop 

Das In-vitro-Adhäsionsverhalten von HPA-1a- und HPA-1b-exprimierenden HEK293-Zellen 

wurde in einer Flusskammer mittels Phasenkontrastmikroskop untersucht. Die Deckgläschen 

wurden mit Fibrinogen (50 μg/ml) beschichtet und eine Stunde bei 37 °C inkubiert. 

Anschließend wurde das überflüssige Fibrinogen mit 1%iger BSA-Lösung abgewaschen. 

300.000 Zellen wurden auf das immobilisierte Fibrinogen gegeben und bei 37 °C 1 Minute 

inkubiert. Die Deckgläschen wurden in die Fräsung der metallenen Untereinheit der 

Strömungskammer positioniert und die einzelnen Elemente der Kammer dicht verschraubt. 

Die Strömungskammer wurde in den Mikroskoptisch gesetzt und die Ausströmkanüle mit der 

50-ml-Perfusorspritze sowie die Einströmkanüle mit dem FCS-freien Reservoir am 

Kulturmedium  verbunden. Die 50-ml-Perfusorspritze mit einem Durchmesser von 18 mm 

war in einer Harvard-Pumpe befestigt. Über den Durchmesser der 50-ml-Perfusorspritze 

berechnet die Harvard-Pumpe die Flussrate in ml/s. Über die Flussrate berechnet sich die 

Scherrate nach folgender Formel:        

             γ = Scherrate in s-1 

                               γ= 6 *Q/w*h2         Q = Flussrate in ml/s
w = Länge des Feldes der Flusskammer (20 mm) 
h = Höhe der Flusskammer (Dicke der Dichtung: 250 μm) 

Die Zellen wurden mit einer Wellenlänge von 458 nm angeregt und deren 

Fluoreszenzemission bei einer Wellenlänge von 485 nm und 538 nm detektiert. Um nicht am 

Fibrinogen haftende Zellen zu entfernen, wurde eine Minute lang eine Initialströmung von 

25 s-1 angelegt. Die Messung erfolgte eine Minute lang bei 25 s-1, 50 s-1
, 100 s-1

, 200 s-1
,     

400 s-1
, 800 s-1 und 1600 s-1 im Stacking-Verfahren mit einem 40x1,3-Öl-Objektiv. Das 

konfokale Laser-Scanning-Mikroskop ist in der Lage, optische Schnitte in räumlich 

ausgedehnten Objekten zu erzeugen, welche schichtweise zu einer räumlichen Darstellung 

zusammengesetzt werden. Ein Aufnahmezyklus bestand aus zwei deckungsgleichen Bildern 

(CFP sowie YFP) über 20 Schnitte, die zu einem Bildstapel vereinigt und in Graustufen 

umgewandelt wurden. Die Stapel-Technik garantiert eine Intensitätsmessung in einem 

gleichbleibenden Messfeld. Es wurde die Intensitätsverteilung der Graustufen (0-255) für 

beide  Kanäle gegenübergestellt und mit ImageJ ausgewertet. Das dazugehörige Macro und 

das Auswerteprozedere sind im Anhang zu finden. 

Zur Validierung des Systems wurden fünf Zellen mit 20 aufeinanderfolgenden Laserimpulsen 

(Photobleaching) auf mit 1 % BSA beschichteten Objektträgern gebleicht. Das BSA dient als 

nicht aktivierende Trägersubstanz. Die Zellen wurden zweimal im Abstand von 30 Sekunden 

jeweils 20 Laserimpulsen ausgesetzt. Als Negativkontrolle wurde die Fluoreszenz von drei 

Zellen ohne Photobleaching über den gleichen Zeitraum gemessen. 
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3 Ergebnisse 

Ziel der vorliegenden Arbeit ist es beide HPA-1-Varianten miteinander zu vergleichen und 

auf ihre Aktivierbarkeit hin zu analysieren. Bei der HPA-1a-Variante des Rezeptors kommt 

an Position 33 ein Leucin (Leu33) und bei der HPA-1b-Variante ein Prolin (Pro33) vor. Für 

die Etablierung einer Zelllinie, die diese αIIbβ3-Integrin-Varianten exprimiert, wurden die 

entsprechenden Konstrukte in HEK293-Zellen transfektiert, amplifiziert und charakterisiert. 

In den durchgeführten Experimenten wurden HEK293-Zellen verwendet, die die HPA-1-

Rezeptorvarianten des αIIbβ3-Integrins exprimieren und für die Untersuchung der kinetischen 

und signalgebenden Eigenschaften des Rezeptors geeignet sind. Die Funktionalität und die 

biologischen Eigenschaften des Rezeptors wurden im Durchflusszytometer, in der Flusskammer, 

im Western-Blot und im Fluorimeter durch spezifische Aktivierung untersucht. Alle Messungen 

wurden an HPA-1a- und HPA-1b-exprimierenden HEK293-Zellen durchgeführt, die eine gleich 

starke αIIbβ3-Expression zeigten. Dementsprechend ist die Rezeptorzahl pro Zelle nicht für den 

beobachteten Unterschied im FRET-Signal verantwortlich sondern die HPA-1-Varianten selbst.

3.1 Expression der HPA-1-Rezeptorvarianten 
3.1.1 Linearisierung der Plasmide 

Um die Aktivierung sowie die damit verbundenen Interaktionen zwischen den 

Rezeptoruntereinheiten αIIb und β3 mittels FRET im Mikroskop und im Fluorimeter 

nachzuweisen und einen Vergleich zwischen HPA-1a- und HPA-1b-Varianten durchzuführen, 

mussten beide Rezeptoruntereinheiten fluoreszenzmarkiert werden. Dazu wurden die 

Plasmide (P101: αIIb-CFP; P92: β3-YFP (Leu33); P96: β3-YFP (Pro33)) über Nacht 

enzymatisch linearisiert (P92 und P96 mit AseI; P101 mit PvuI), um sie anschließend in 

HEK293-Zellen transfektieren zu können. Die qualitative Kontrolle erfolgte mittels 

Agarosegel-Elektrophorese (Abb. 7). Der Vergleich der linearisierten mit den nicht 

linearisierten Plasmiden im Agarosegel zeigte deutliche Unterschiede. Die nicht linearisierte 

Form von P101 lässt Banden bei weit über 10 kb und bei etwa 5,5 kb erkennen. Die 

linearisierte Form von P101 dagegen lief bei knapp 9 kb. Die Spur des nicht linearisierten P92 

und P96 zeigte Banden bei weit über 10 kb und bei 4 kb auf, die Spur des linearisierten P92 

und P96 wies jeweils nur eine Bande bei etwa 8 kb auf. 

Abbildung 7: Gelelektrophoretische Analyse der linearisierten Plasmide 
Proben der nicht linearisierten und linearisierten Plasmide wurden zur Qualitätskontrolle im 0,6%igen 
Agarosegel aufgetrennt. lin.: Plasmide nach der Linearisierung; Marker: 1 Kb Leiter.

P92 
P92 
lin. 

-------- P96 
P96 
lin. 

-------- M -------- P101 
P101 
lin. 
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3.1.2 Spezifische αIIbβ3-Integrin-Expression auf der Zellmembran 

Für die Transfektion der HEK293-Zellen wurden die linearisierten Plasmide verwendet. Für 

die Doppeltransfektion wurden die Zellen mit je einer α- und einer β-Untereinheit des 

Rezeptorgens transfektiert und selektiv amplifiziert. Durch „Magnetic-Activated Cell 

Sorting“ (MACS) wurden doppelt transfektierte Zellen angereichert, die daraufhin vereinzelt 

und kultiviert wurden. Mittels FRET-Analysen wurde bestimmt, ob das Protein synthetisiert 

wurde. Die Zellen wurden dazu im konfokalen Laser-Scanning-Mikroskop mit einer 

Wellenlänge von 458 nm angeregt und auf blaue und gelbe Fluoreszenz untersucht (Abb. 8). 

Die in Abb. 8 dargestellten Zellen emittieren sowohl blaue (485 nm) als auch gelbe (538 nm) 

Fluoreszenz. Die Fluoreszenz ist in der Zellmembran stärker sichtbar als im Zytoplasma, 

wobei die Emissionen der beiden Wellenlängen deckungsgleich sind. Die αIIbβ3-Integrin-

Expression wurde anschließend durch SDS-PAGE und Western-Blot-Analysen bestätigt. 

Abbildung. 8: Lokalisation der αIIb-CFP/β3-YFP-Interaktionen mittels FRET
Fluoreszenzmikroskopische Aufnahmen doppelt transfektierter HEK293-Zellen: Exemplarisch sind Zellen 
dargestellt, die αIIb-CFP/β3-YFP exprimieren. A: emittiertes Licht der Wellenlänge 538 nm; B: emittiertes Licht 
der Wellenlänge 485 nm, angeregt durch 458 nm.

CFP 
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Em. 485 nm 

YFP 

Em. 538 nm 

A
HPA-1a HPA-1b  
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3.1.3 αIIbβ3-Integrin-Expressionsnachweis mittels Western-Blot-Analysen 

SDS-PAGE und anschließende Western-Blot-Analysen (Abb. 9) von Zelllysaten aus 

transfektierten HEK293-Zellen sollen die fluoreszenzmikroskopischen Analysen (Abb. 8) 

bestätigen. Die Detektion der transfektierten Zellmembranproteine wurde mit Anti-αIIb-, Anti-

β3- sowie Anti-GFP-Antikörper, welcher mit CFP und YFP kreuzreagiert, durchgeführt. Als 

Negativkontrollen dienten Zelllysate, die mit dem Ausgangsvektor (pcDNA3.1) transfektiert 

wurden. Durch die am C-Terminus fusionierten Fluoreszenzproteine hat die αIIb-Untereinheit 

ein Molekulargewicht von 167 kDa anstatt von 140 kDa und die β3-Untereinheit ein 

Molekulargewicht von 132 kDa anstatt von 105 kDa (Abb. 9 A und 9 B). Die mit Anti-GFP-

Antikörper detektierte Membran zeigt bei den Einzeltransfektanten jeweils eine Bande bei 

167 kDa (αIIb-CFP ) oder bei 132 kDa (β3-YFP) auf. Lediglich bei den Doppeltransfektanten, 

welche den intakten Rezeptor exprimieren, war eine Doppelbande bei 167 kDa und bei 

132 kDa zu erkennen. 

    
  
                                                              

Abbildung 9: Western-Blot zur Darstellung der αIIbβ3-Expression in HEK293-Zellen 
Die HEK293-Zellen wurden mit den unterschiedlichen Rezeptoruntereinheiten transfektiert, durch nicht 
reduzierende SDS-PAGE aufgetrennt, auf eine Membran transferiert und mit Anti-αIIb-AK (αIIb-spezifisch) (A), 
Anti-β3-AK (β3-spezifisch) (B) oder Anit-GFP-AK (CFP- und YFP-spezifisch) (C) detektiert. 

Anhand der Western-Blot-Analysen war ersichtlich, dass Integrin αIIbβ3 mit den jeweiligen 

fusionierten Fluoreszenzproteinen (CFP an die α-Untereinheit; YFP an die β-Untereinheit) in 

HEK293-Zellen erfolgreich transfektiert und exprimiert wurde. Dementsprechend konnten die 

Fluoreszenzmikroskopischen-Analysen bestätigt werden (Abb. 8). 
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3.1.4 Funktionelle αIIbβ3-Integrin-Expression auf HEK293-Zellen 

Zellen, die eine gleich starke αIIbβ3-(HPA-1a bzw. HPA-1b) Zelloberflächen-Expression 

aufwiesen, wurden selektiert und die Fusionskonstrukte daraufhin auf ihre Funktionalität 

untersucht. Mit den durchgeführten Experimenten in der Durchflusszytometrie wurde die 

funktionale Rezeptorintegrität des αIIbβ3-Integrins nachgewiesen. Hierzu wurden die 

Rezeptorvarianten mit Agonisten wie Phorbol-12-Myristat-13-Acetat (PMA) oder 1-Stearoyl-

2-Arachidonoyl-sn-Glycerol (SAG) behandelt. PMA aktiviert die Proteinkinase C, was zur 

Stimulation des αIIbβ3-Integrins führt. SAG dagegen bindet zunächst an G-Protein gekoppelte 

Rezeptoren und aktiviert über diese die Proteinkinase C. Danach wurde Alexa-647-

gekoppeltes Fibrinogen hinzugegeben, welches von aktivierten Rezeptoren gebunden und im 

Durchflusszytometer detektiert werden konnte (Abb. 10). Zu erkennen ist, dass nach Zugabe 

von PMA eine verstärkte Bindung zu Fibrinogen vorhanden ist (Abb. 10 A). Um den Effekt 

der G-Protein-gekoppelten Rezeptor-Signalwege auf die Konformation der zytoplasmatischen 

Integrin-Domänen zu untersuchen, wurden die G-Protein-gekoppelten Rezeptoren mit SAG 

behandelt und eine verstärkte Bindung zu Fibrinogen detekiert (Abb. 10 B). PMA und SAG 

stimulieren die physiologische Inside-out-Aktivierung der Integrine, die mit einer räumlichen 

Trennung der zytoplasmatischen α- und β-Domänen von HPA-1a- und HPA-1b-Varianten 

einhergeht. Die Fibrinogenbindung bzw. der Rezeptor lässt sich mit dem αIIbβ3-Antagonisten 

Abciximab blockieren. Zusätzlich ist die Bindung von Fibrinogen nach Zugabe von SAG 

durch Pertussis-Toxin (PTX) blockierbar (Abb. 10 B). Die PTX-Zellbehandlung blockiert die 

G-Protein-gekoppelten Rezeptoren und verhindert dadurch die Wirkung von Agonisten. 

Sowohl nach PTX- als auch nach Abciximab-Zellbehandlung war keine Fibrinogenbindung 

zu erkennen.  Wie in Abb. 10 zu erkennen ist, wiesen die unstimulierten Zellen eine niedrige 

Fluoreszenz auf. Die Alexa-647-Fluoreszenz von Zellen, die mit PMA und SAG behandelt 

wurden, war nahezu identisch. Die Fluoreszenzintensitäten der mit Antagonisten behandelten 

Rezeptoren waren fast deckungsgleich mit denen der unbehandelten Rezeptoren. 
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Abbildung 10: Durchflusszytometrische Funktionalitätsanalyse der aktivierten αIIbβ3-Zellen  
Die Zellen wurden mit Fibrinogen Alexa-647 inkubiert und zuvor mit PMA (A) oder SAG (B) stimuliert 
(schwarz). Parallel dazu wurden die Zellen mit Abciximab (rot) bzw. PTX (grün) blockiert. Als Kontrolle 
wurden nicht stimulierte Zellen (grau) durchflusszytometrisch untersucht. 

Die durchgeführten Untersuchungen der Funktionalität und Bindungsfähigkeit der 

Rezeptorvarianten an Fibrinogen mit Agonisten und Antagonisten zeigte: Sowohl die  HPA-

1a- als auch die HPA-1b-Variante lassen sich spezifisch aktivieren und blockieren.
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3.2 Quantifizierung des αIIbβ3-Integrins auf der Zelloberfläche 

Die mit αIIb-CFP/β3-YFP transfektierten HEK293-Zellen wurden mit dem 

komplexspezifischen CD41-Antikörper (PM6/248), der gegen die αIIb-Untereinheit gerichtet 

ist, inkubiert. Ein Anti-Maus-PE-markierter Antikörper diente als Sekundärantikörper. 

Abb. 11 zeigt die durchflusszytometrische Detektion des αIIbβ3-Integrins auf der 

Zelloberfläche exemplarisch an einer Rezeptor-Variante in der Durchflusszytometrie. Es ist 

zu erkennen, dass das αIIbβ3-Integrin auf den HEK293-Zellen exprimiert wird.  

Abbildung 11: Durchflusszytometrische Analyse zur Darstellung der αIIbβ3-Expression 
Exemplarische PE-Fluoreszenz für einen Zellklon, der mit dem CD41-PE-Antikörper behandelt wurde 
(schwarz). Als Kontrolle wurde der Klon mit anti-Maus IgG1-PE inkubiert (grau).  

Beide Varianten wurden, wie in Abb. 11 gezeigt, gemessen und die αIIbβ3-Expression mithilfe 

der Rainbow-Kalibrationspartikel ermittelt (Tabelle 3). Über die Fluoreszenzäquivalente und 

die PE-Ratio des Sekundärantikörpers ließ sich die Rezeptorzahl berechnen. 

HPA-1a HPA-1b 

n 9 9 

Isotyp (Mittelwert) 8,58 8,51 

αIIbβ3-Expression (Mittelwert) 116,18 117,64 

Fluoreszenzäquivalent 1630975 1657383 

Rezeptorzahl ≈ 600.000 ≈ 600.000 

Tabelle 3: Bestimmung der αIIbβ3-Integrinzahl auf der Zelloberfläche 
         
Beide HPA-1-Rezeptorvarianten des αIIbβ3-Integrins zeigten im Durchflusszytometer eine 

ähnliche Rezeptorzahl von 600.000. Ausschließlich diese wurden selektiert und in den 

anschließenden Experimenten verwendet.  
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3.3 αIIbβ3-Integrin-Charakterisierung in HPA-1-Varianten

Der CD-61-PE-Antikörper (Klon: SZ21) wurde verwendet, um zwischen HPA-1a- und HPA-

1b-exprimierenden HEK293-Zellen zu unterscheiden, da der Antikörper mit einer viel 

niedrigeren Affinität an die HPA-1b-Isoform bindet (Weiss, 1995). Diese Beobachtung 

konnte in dieser Arbeit bestätigt werden, denn die durchflusszytometrischen Analysen an 

αIIbβ3-exprimierenden Zellen zeigten eine deutlich reduzierte Bindung von CD61-PE bei 

HPA-1b-exprimierenden Zellen (Abb. 12). 

     

Abbildung 12: Durchflusszytometrische Charakterisierung der HPA-1-Varianten 
Das durchflusszytometrische Diagramm zeigt die Charakterisierung der HPA-1a- (schwarz) bzw. HPA-1b- (rot) 
exprimierenden Zellen mit einem HPA-1a-spezifischen Antikörper. Als Kontrolle wurde der Klon mit anti-Maus 
IgG1-PE inkubiert (grau).  

Zusätzlich wurde das Vorhandensein der HPA-1a- bzw. der HPA-1b-Variante mittels cDNA 

basierender RFLP validiert (Abb. 13). Durch den Basenaustausch an Position 1565 von 

Thymin zu Cytosin beim HPA-1b-Genotyp ergibt sich eine zusätzliche 

Restriktionsschnittstelle für ScrFI. Die DNA der HPA-1a-exprimierenden Zellen weisen zwei 

Schnittstellen bzw. drei Banden auf (106 bp, 92 bp und 23 bp), während die DNA der HPA-

1b-exprimierenden Zellen über drei Schnittstellen bzw. vier Banden verfügen (92 bp, 80 bp, 

26 bp und 23 bp). Die spezifischen Restriktionsprodukte von HPA-1a und HPA-1b konnten 

im Polyacrylamidgel positiv nachgewiesen werden.  

Abbildung 13: Restriktionsanalysen der HPA-1-exprimierenden HEK293-Zellen mit ScrFI 
Restriktionsprodukte von HPA-1a und HPA-1b wurden auf einem 12%igen Polyacrylamidgel aufgetragen und 
nach ihrer Größe getrennt. 
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3.4 FRET-Analysen

Die Analysemethode FRET dient zur Untersuchung der räumlichen Nähe zwischen den 

zytoplasmatischen Domänen in-vivo, um so Rückschluss auf den Aktivierungszustand des 

αIIbβ3-Integrins zu erhalten. Befindet sich das αIIbβ3-Integrin im Ruhezustand, so besteht eine 

räumliche Nähe zwischen der α- und der β-Transmembran-Domäne. Der Abstand zwischen 

der zytoplasmatischen α- und β-Untereinheit ist essenziell für die Integrinaktivierung (Kim, 

2003). Beim bidirektionalen Integrin-Signaling kommt es zu einer extrazellulären 

Konfomationsänderung, bei der sich die Rezeptorarme öffnen und sich eine Trennung der 

zytoplasmatischen α- und β-Domäne anschließt. Dies ist ein wichtiger Mechanismus für die 

Vermittlung von Informationen durch die Zellmembran (Kim, 2003). 

3.4.1 Basale FRET-Effizienz

Um FRET als Messsystem zu validieren und die basale FRET-Effizienz zu messen, wurde die 

Akzeptor-Photobleach-Methode angewandt. Bei dieser Methode wird die Donor (CFP)-

Fluoreszenz-Intensität vor und nach der akzeptorspezifischen Photodestruktion verglichen 

(Abb. 14). Dabei kommt es zu einer kompletten Akzeptor (YFP)-Ausbleichung. Bei der 

anschließenden Donor-Fluoreszenzmessung kommt es zu einem Anstieg der CFP-Intensität, 

abhängig von der zuvor auf den Akzeptor transferierten Energie. Es ist zu erkennen, dass nach 

dem Akzeptor-Bleaching die Akzeptoremission erlischt und die Donoremission stark 

zunimmt. Je stärker die Donor-Intensitätszunahme ist, desto kleiner ist der Abstand zwischen 

den zytoplasmatischen Domänen, was mit einer inaktiven Konformation des Rezeptors 

einhergeht (Kim, 2003).  

Abbildung 14: Akzeptor-Bleaching zur Darstellung der FRET-Effizienz 
Es wurde exemplarisch an einer Zelle die Fluoreszenz des Donors und des Akzeptors vor und nach dem 
Akzeptor-Bleaching bei 514 nm gemessen.
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Nach Auswertung der Akzeptor-Bleaching-Experimente ist zu erkennen (Abb. 15), dass die 

FRET-Signale der HPA-1a- und der HPA-1b-Rezeptorvarianten im Ruhezustand einen 

signifikanten Unterschied aufweisen (HPA-1a: 197,63 ±56,07 %; HPA-1b: 146,95 ±28,84 %; 

p=0,0001). Daraus ist zu schließen, dass die Distanz zwischen den zytoplasmatischen 

Domänen bei der HPA-1b-Rezeptorvariante größer ist als bei der HPA-1a-Rezeptorvariante. 

Nach Stimulation des Rezeptors mit PMA (induziert Inside-out-Signaling) ist ein größerer 

Unterschied in der Donorintensität zwischen dem aktivierten und dem ruhenden Zustand bei 

der HPA-1a-Rezeptorvariante zu beobachten (HPA-1a: 175,73 ±50,08 %; 197,63 ±56,07 %; 

p=0,0327), (HPA-1b: 141,15 ±25,42 %; 146,95 ±28,84 %; p=0,2458). 

Abbildung 15: Donoremissionszunahme nach dem Akzeptor-Bleaching 
Dargestellt ist die Donoremission nach dem Akzeptor-Bleaching. Der Akzeptor der  Rezeptorvarianten wurde im 
nicht aktivierten Zustand und im aktivierten Zustand gebleicht und die Donoremissionszunahme im Anschluss 
daran prozentual gemessen.  

Die Ergebnisse deuten darauf hin, dass sich die Aktivierungszustände, die durch PMA 

induziert werden, unterschiedlich auf die Rezeptorvarianten auswirken.  
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3.4.2 FRET-Analysen unter statischen Bedingungen 

Um den Effekt der Ligandenbindung  auf die Orientierung der zytoplasmatischen Domänen 

zu untersuchen, wurden die HPA-1-Rezeptorvarianten (HPA-1a bzw. HPA-1b) mit PMA, 

SAG sowie Mn2+ bzw. auf immobilisiertem Fibrinogen inkubiert. Die 

Konformationsänderung des αIIb-CFP/β3-YFP (HPA-1a und HPA-1b) in Anwesenheit der 

Agonisten PMA, SAG, Mn2+ und immobilisiertem Fibrinogen verursacht eine Abnahme des 

FRET-Signals verglichen mit Zellen, die nicht mit den Agonisten behandelt wurden (Abb. 

16). Die durch PMA und SAG induzierte Konformationsänderung des αIIb-CFP/β3-YFP-

Integrins wirkt über das Inside-out-Signaling stärker auf die HPA-1a-Rezeptorvariante als auf 

die HPA-1b-Rezeptorvariante (PMA (1 μM); HPA-1a: 59,26 ±4,5 %; HPA-1b: 64,3 ±8 %; 

p=0,0001), (SAG (30 nM); HPA-1a: 69,82 ±3,8 %; HPA-1b: 70,59 ±4,6 %; p=0,3562). Einen 

gegenteiligen Effekt haben outside-in-induzierende Agonisten wie Mn2+ und immobilisiertes 

Fibrinogen (Mn2+ (0,5 mM); HPA-1a: 72,85 ±5,7 %; HPA-1b: 66,9 ±5,7 %; p=0,0053), (Fg 

(100 μg/ml); HPA-1a: 78,29 ±7,1 %; HPA-1b: 73,53 ±5,6 %; p=0,0447).  

Abbildung 16: Relative FRET-Abnahme von HPA-1-exprimierenden Zellen unter statischer Adhäsion
HPA-1a- und HPA-1b-exprimierende Zellen wurden mit verschiedenen Agonisten, welche Inside-out- bzw. 
Outside-in-Signaling induzieren, stimuliert und die FRET-Signalabnahme gemessen. 

Diese Ergebnisse zeigen, dass die durch bidirektionales Signaling vermittelte Aktivierung des 

Rezeptors mit einer räumlichen Trennung der zytoplasmatischen αIIb- und β3-Domänen 

assoziiert ist. Außerdem wird deutlich, dass die Aktivierungszustände, die durch die 

verschiedenen Agonisten induziert werden, unterschiedlich auf die Rezeptorvarianten wirken. 
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3.4.3 FRET-Analysen unter Strömungsbedingungen 

Die Adhäsion von Thrombozyten an extrazelluläre Matrixproteine infolge von 

Gefäßverletzungen wird unter anderem durch lokale Scherkräfte reguliert (Nesbitt, 2009). Um 

die Adhäsion unter flussdynamischen Bedingungen zu untersuchen, wurde der Effekt der 

Ligandenbindung auf die Orientierung der zytoplasmatischen Domänen untersucht. Dabei 

wurden die Zellen auf immobilisiertem Fibrinogen (50 μg/ml) inkubiert und anschließend 

immer stärker werdenden Scherraten ausgesetzt. Im Vergleich zu statischen Bedingungen 

erhöht sich die Affinität des αIIbβ3-Integrins unter Strömungsbedingungen und erreicht eine 

verbesserte Bindung zum immobilisierten Fibrinogen, was zu einer signifikanten FRET-

Abnahme in Richtung HPA-1b-Rezeptorvariante führt (Abb.17). Ab 400 s-1 konnte bei der 

Akzeptoremission ein stärker werdender Unterschied zwischen der HPA-1a- und der HPA-

1b-Rezeptorvariante beobachtet werden, der ab 800 s-1 signifikant wurde (800 s-1: HPA-1a: 

79,63 ±14,49 %; HPA-1b: 67,33 ±14,04 %; p=0,0014; 1600 s-1: HPA-1a: 73,62 ±13,17 %; HPA-1b: 

63,21 ±13,01 %; p=0,0029). Die Donoremissionszunahme ist für die FRET-Analysen 

charakteristisch und dient zusätzlich als interne Kontrolle. Ein signifikanter Unterschied bei 

der Zelladhäsionsaktivität im Hinblick auf die HPA-1-Rezeptorvarianten wurde nur unter 

stärker werdenden Strömungsbedingungen zwischen HPA-1a und HPA-1b beobachtet.  

In drei Experimenten wurden die Zellen zusätzlich zehn Minuten lang mit dem Antagonisten 

Abciximab (4 μg/ml) inkubiert. Eine Perfusion der vorinkubierten Zellen auf Fibrinogen-

beschichtetem Objektträger zeigte keine Adhäsion. Ähnlich verhielten sich die Zellen in drei 

Experimenten auf BSA-beschichtetem Objektträger. 

Abbildung 17: Relative Fluoreszenzintensität der HPA-1-exprimierenden Zellen unter Strömungsbedingungen
Es wurden die relativen Fluoreszenzintensitäten der mit CFP bzw. YFP gekoppelten HPA-1a (schwarz) und 
HPA-1b (rot) -Rezeptorvarianten  in Abhängigkeit zunehmender Scherraten gemessen. 
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Zur Validierung des Systems wurden die CFP- und die YFP-Fluoreszenz der zu 

untersuchenden Zellen nach wiederholtem Akzeptor-Bleaching gemessen. Als Kontrolle 

dienten Zellen, die nicht gebleicht wurden. In der Abbildung 18 ist zu erkennen, dass nach 

dem Akzeptor-Bleaching die Donor-Emission zunimmt und im Gegensatz dazu die 

Akzeptoremission abnimmt. Bei den nicht gebleichten Zellen verändern sich die Emissionen 

über die Zeit nur marginal. 

Abbildung 18: Validierung der FRET-Analysen unter Strömungsbedingungen
Es wurden die Emissionseigenschaften der Fluorophore auf 1 % BSA mit und ohne Akzeptor-Bleaching 
gemessen.  

3.5 Essenzielle Proteine der αIIbβ3-Integrinaktivierung 

SDS-PAGE und anschließende Western-Blot-Analysen (Abb. 19) von Zelllysaten aus 

Thrombozyten, HEK293-Zellen und HPA-1a- bzw. HPA-1b-exprimierenden Zellen wurden 

auf Talin-Expression untersucht, welche eine wichtige Rolle bei der Initiierung und 

Weiterleitung des bidirektionalen Signalings hat. 

Abbildung 19: Western-Blot-Analysen zur Darstellung des essenziellen Adapterproteins Talin 
25 μg Zelllysate wurden durch nicht reduzierende SDS-PAGE aufgetrennt, auf eine Membran transferiert und 
mithilfe des monoklonalen Anti-Talin-Antikörpers detektiert. 

Sowohl in HEK293-Zellen, Thrombozyten als auch in HPA-1-exprimierenden HEK293-

Zellen konnte die Expression von Talin (235 kDa) mittels SDS-PAGE und Western-Blot-

Analyse nachgewiesen werden (Abb. 19). 
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3.6 Src-Aktivierung in HPA-1-Rezeptorvarianten 

Die Messung der intrazellulären Src-Kinase-Phosphorylierung in HPA-1a- und HPA-1b-

Zelllysaten gibt einen Aufschluss über den Grad der Rezeptoraktivierung. 

Die HPA-1a- und die HPA-1b-Rezeptorvarianten wurden mit verschiedenen Agonisten 

stimuliert: das Inside-out-Signaling erfolgte über PMA, während für das Outside-in-Signaling 

Mn2+ und immobilisiertes Fibrinogen verwendet wurden. Als Kontrolle wurden Zellen auf 

BSA inkubiert. In einem vierten Ansatz wurden die Rezeptorvarianten zunächst mit dem 

Antagonisten Abciximab und anschließend mit den outside-in-stimulierenden Agonisten 

behandelt. Die absolute Src-Kinase-Menge (Gesamt-Src) und die phosphorylierte Src-Kinase-

Menge Src p418 wurde mittels Western-Blot detektiert und densitometrisch quantifiziert 

(Abb. 20). Die Inkubation der Zellen mit dem αIIbβ3-Integrin-Antagonisten Abciximab 

verursachte eine stärkere Blockierung der HPA-1a-Aktivierung (ca. 33 %). Des Weiteren war 

ein signifikanter Unterschied zwischen inside-out- und outside-in-induzierender Src-Kinase-

Phosphorylierung zu erkennen (HPA-1a: p=0,007; HPA-1b p=0,0299). Eine Erhöhung der 

Src-Kinase-Phosphorylierung wurde in den HPA-1b-exprimierenden Zellen im Vergleich zu 

den HPA-1a-exprimierenden Zellen (HPA-1a: 178,24 ±25,07 %; HPA-1b: 200,44 ±36,39; 

p=0,24), die an Fibrinogen adhärieren, beobachtet. 

   

Abbildung 20: Densitometrische Quantifizierung der Src-Kinase-Phosphorylierung in HPA-1-Varianten
Die Rezeptorliganden-abhängige Src-Phosphorylierung in den unterschiedlich stimulierten Zelllysaten wurde 
mit phosphorspezifischen Antikörpern gegen Src pY418 und Total Src im Western-Blot detektiert und mithilfe 
von Densitometrie quantifiziert. 
  

Diese Ergebnisse geben einen Hinweis darauf, dass das postrezeptorische αIIbβ3-Signaling in 

HPA-1-Zellen unterschiedlich verläuft und belegen die funktionellen Unterschiede in HPA-1a 

und HPA-1b nach der Rezeptoraktivierung.  
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4 Diskussion 

Integrine sind essenziell für die Entwicklung, Immunität und Wundheilung wie auch für 

Metastasierung von Krebszellen und die Zytoskelett-Reorganisation. Sie gehören zu den 

Plasmamembran-Rezeptoren, bei denen die grundlegenden Signalmechanismen und 

Aktivierungsvorgänge noch nicht vollständig verstanden sind. Vor allem die Mechanismen, 

bei denen Informationen bidirektional übertragen werden, sind noch unklar.  

Das Integrin αIIbβ3 findet sich vor allem auf der Oberfläche von Thrombozyten und ist 

entscheidend für deren durch Fibrinogen vermittelte Vernetzung. Wie alle anderen Integrine 

ist auch αIIbβ3-Integrin zu bidirektionalem Signaling fähig, d. h. αIIbβ3-Integrin ist in der Lage, 

sowohl intrazelluläre Signale nach außen als auch extrazelluläre Signale nach innen 

weiterzuleiten. Die Erforschung dieses Integrin-Typs hat sich als Ziel gesetzt, zum einen ein 

besseres Verständnis der grundlegenden molekularen Mechanismen der Signaltransduktion zu 

erreichen. Zum anderen soll αIIbβ3-Integrin ein potenzieller Ansatzpunkt für die 

pharmakotherapeutische Behandlung von Krankheiten sein, die in einem Zusammenhang mit 

der Blutgerinnung stehen.  

Das Ziel dieser Arbeit war der Vergleich der zytoplasmatischen Konformationsänderungen 

und damit des Aktivierungszustandes zwischen den αIIbβ3-Integrin-Varianten HPA-1a und 

HPA-1b. Bei der HPA-1a-Variante der β3-Untereinheit befindet sich die Aminosäure Leucin 

an Position 33, während bei der seltener auftretenden HPA-1b-Variante aufgrund eines 

„Single Nucleotid Polymorphismus“ an selbiger Stelle ein Prolin vorkommt. 

4.1 Expression der Rezeptorvarianten 

Im Rahmen dieser Arbeit ist es gelungen, beide Rezeptorvarianten in HEK293-Zellen zu 

exprimieren. Die Western-Blot-Analyse mit Antikörpern, die spezifisch an die αIIb- bzw. die 

β3-Untereinheit des Integrins binden, zeigten Banden auf der Höhe von 167 kDa (β3-

Untereinheit) bzw. 132 kDa (αIIb-Untereinheit) (Abb. 9 A/B). Dies entspricht dem 

theoretischen Molekulargewicht der jeweiligen Untereinheit gekoppelt mit dem fusionierten 

Fluoreszenzprotein. Zum anderen konnte die Präsenz der an Untereinheiten gekoppelten 

Fluoreszenzproteine YFP und CFP direkt durch einen spezifischen Antikörper nachgewiesen 

werden (Abb. 9 C). Die dabei aufgetretenen Banden entsprachen dem Molekulargewicht der 

Fusionsproteine. Einzeltransfektanten wiesen dagegen jeweils nur eine Bande auf. Daraus 

lässt sich schließen, dass die Zellen die Integrin-Fusionsproteine exprimieren. 

Mittels durchflusszytometrischer Analyse mit einem CD41-Antikörper, der den αIIbβ3-

Integrin-Komplex spezifisch erkennt, wurde ersichtlich, dass der Rezeptor auf der 
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Zellmembran lokalisiert ist (Abb. 11). Dies spricht für die Insertion des Rezeptors in die 

Plasmamembran. Bei YFP- bzw. CFP-Einzeltransfektanten war die Fluoreszenz im Golgi-

Apparat verteilt (Daten nicht gezeigt), dementsprechend ist eine einzelne 

Rezeptoruntereinheit nicht in der Lage, auf der extrazellulären Seite der Membran exprimiert 

zu werden (O`Toole, 1989). Bei den mit dem intakten Rezeptor transfektierten Zellen war die 

blaue und die gelbe Fluoreszenz deckungsgleich (Abb. 8). Die Untereinheiten sind demnach 

auf der Membran kolokalisiert. Diese Beobachtung lässt darauf schließen, dass die 

Fluoreszenzmarkierung an den Rezeptoruntereinheiten (CFP an der α-Untereinheit und YFP 

an der β-Untereinheit) keinen Einfluss auf deren Lokalisation haben. 

 Um sicherzustellen, dass die Ergebnisse der HPA-1a- und HPA-1b-Varianten direkt 

miteinander verglichen werden können, wurde jeweils die Rezeptorzahl auf den 

Zelloberflächen mit dem komplexspezifischen αIIbβ3-Integrin-Antikörper bestimmt und 

daraufhin lediglich Klone mit vergleichbarer Rezeptorzahl für nachfolgende Experimente 

verwendet (Tabelle 3). 

4.1.1 Funktionalität des αIIbβ3-Integrins 

Die als HPA-1a und als HPA-1b identifizierten Zellklone sollten nicht nur den intakten 

Rezeptor in seinen verschiedenen Formen synthetisieren, sondern auch die funktionelle 

Integrität des Rezeptors gewährleisten. Die biologischen Eigenschaften sowie Funktionen und 

damit auch die Aktivierbarkeit der Rezeptorvarianten sollten durch die Transfektion nicht 

beeinträchtigt werden, um später Vergleiche zwischen HPA-1a- und HPA-1b-Varianten zu 

ziehen und deren Bindung an verschiedenen Liganden analysieren zu können. Hierzu wurden 

die Rezeptoren mit PMA oder SAG aktiviert (Inside-out-Signaling) und anschließend die 

Bindung von fluoreszenzmarkiertem Fibrinogen gemessen (Abb. 10). Die Bindung von 

fluoreszenzmarkiertem Fibrinogen nach Stimulation mit SAG war nahezu identisch mit dem 

Signal der PMA-aktivierten αIIbβ3-Integrine, während nicht aktivierte Rezeptoren keine 

Bindung aufwiesen. Der untersuchte Klon synthetisiert demnach intaktes αIIbβ3-Integrin, 

welches sich durch Agonisten spezifisch aktivieren lässt. Die leicht erhöhte Fluoreszenz der 

PMA-aktivierten Rezeptoren resultiert möglicherweise daraus, dass PMA den Rezeptor direkt 

über die Proteinkinase C aktiviert (Morii, 1992), wohingegen SAG indirekt über die G-

Protein-gekoppelten Rezeptoren wirkt (Alderton, 2001). Es ist denkbar, dass die direkte 

Aktivierung eine andere Konformationsänderung im Vergleich zu der Aktivierung auf 

indirektem Weg hervorruft. Wurde der Rezeptor zuvor mit dem Antagonisten Abciximab 

behandelt, so konnte αIIbβ3-Integrin Fibrinogen weder nach Stimulierung mit PMA noch mit 
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SAG binden, was auf eine spezifische Blockierung des αIIbβ3-Integrins mit Abciximab 

zurückzuführen ist. Nach Blockierung der G-Protein-gekoppelten Rezeptoren mit dem 

Antagonisten Pertussis-Toxin hat SAG keine Wirkung auf die αIIbβ3-Integrinaktivierung. 

Zusammenfassend kann gesagt werden, dass die Zellen den intakten Rezeptor exprimieren. 

Der vorhandene Rezeptor ist mittels Agonisten aktivierbar und in der Lage Fibrinogen zu 

binden. Nach Behandlung mit Antagonisten lässt sich der Rezeptor nicht mehr aktivieren. 

4.2 Validierung der HPA-1a- und HPA-1b-Rezeptorvarianten

Im nächsten Schritt war es wichtig zu zeigen, dass die verwendeten Zellklone die HPA-1a- 

bzw. die HPA-1b-Variante des αIIbβ3-Integrins exprimieren. 

Hierzu wurde mittels durchflusszytometrischer Analyse die Bindungssaffinität der Zellen für 

einen β3-Untereinheit-spezifischen Antikörper untersucht (Abb. 12). Der verwendete 

CD61(Klon SZ21)-Antikörper bindet deutlich stärker an die HPA-1a-Variante des Rezeptors. 

Die HPA-1a-exprimierenden Zellen zeigten wie erwartet eine stärkere Bindung des 

Antikörpers als die HPA-1b-exprimierenden Zellen. 

Um dieses Ergebnis zu bestätigen, wurde eine „Restriction Fragment Length Polymorphism“ 

(RFLP)-Analyse  an den HPA-1-Varianten durchgeführt (Abb. 13). Während die HPA-1a-

Variante zwei Restriktionsschnittstellen für ScrFI aufweist und sich damit bei einer RFLP-

Analyse in drei Banden auftrennt, verfügt die HPA-1b-Variante über drei solcher 

Schnittstellen und führt damit zu vier unterschiedlichen Banden. Dieses Verhalten konnte bei 

den Zellklonen nachgewiesen werden. Dies spricht dafür, dass die transfektierten HEK293-

Zellen die jeweiligen Rezeptorvarianten exprimieren. 

4.3 Validierung der FRET-Analysemethode

Für die weiteren Messungen war es nötig, die auf dem Förster-Transfer beruhende 

Analysemethode zu validieren. Über das Akzeptor-Bleaching vor und nach Aktivierung des 

Rezeptors können dann Aussagen über die Abstandsverhältnisse der zytoplasmatischen 

Domänen während der verschiedenen Aktivierungszustände getroffen werden (Kim, 2003). 

Mittels Ausbleichen des Akzeptors (YFP) wurde nachgewiesen, dass es sich bei der 

sichtbaren Fluoreszenz um ein FRET-Signal  handelt (Abb 14). In den Experimenten konnte 

gezeigt werden, dass das an die αIIb-Untereinheit gebundene Donormolekül CFP durch ein 

Bleichen des an die β3-Untereinheit gebundenen Akzeptormoleküls YFP eine deutlich höhere 

blaue Fluoreszenz aufwies, während die Fluoreszenz von YFP völlig verschwand.  
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Aufgrund der Ergebnisse lässt sich schließen, dass es möglich ist, die HPA-1a- und die HPA-

1b-exprimierenden Zellen mittels FRET-Analyse funktionell zu charakterisieren.  

4.3.1 Charakterisierung der Rezeptorvarianten unter statischen Bedingungen 

Bei den FRET-Analysen im Fluorimeter sollte das Verhalten der Rezeptorvarianten sowie 

ihrer zytoplasmatischen Domänen  in Gegenwart von verschiedenen Agonisten getestet 

werden (Abb. 16). 

Im inaktiven Zustand befinden sich die Rezeptoruntereinheiten in unmittelbarer Nähe 

zueinander. Nach Aktivierung des Rezeptors kommt es zu einer räumlichen Trennung der 

Rezeptoruntereinheiten. Die Integrinaktivierung kann durch Inside-out- bzw. Outside-in-

Signaling erfolgen. In einer früheren Arbeit wurde bereits gezeigt, dass beim Signaling durch 

die Plasmamembran beim strukturell ähnlichen αVβ3-Rezeptor die extrazelluläre 

Konformationsänderung mit einer räumlichen Separierung der zytoplasmatischen Domänen 

gekoppelt ist (Kim, 2003). Diese Vorgänge sind bei Integrinen sowohl beim Inside-out- als 

auch beim Outside-in-Signaling vorhanden (Arnaout, 2005). 

Die Experimente zeigten, dass der direkt an der Proteinkinase C angreifende Inside-out-Aktivator 

PMA  zu einem signifikant geringeren Fluoreszenz-Transfer von HPA-1a-Zellen im Vergleich zu 

HPA-1b-Zellen führte. Dies kann als eine geringere Aktivierung der HPA1b-Variante interpretiert 

werden. Im Gegensatz dazu führte die Präsenz des über ein G-Protein wirkenden Aktivators SAG 

zu keiner unterschiedlichen Intensität des Fluoreszenz-Transfers bei den beiden 

Rezeptorvarianten. Die Outside-in-Agonisten Mn2+ und immobilisiertes Fibrinogen führten bei 

der HPA-1b-Variante zu einer signifikant stärkeren Abnahme des FRET-Signals. 

Die stärkere FRET-Signalabnahme der HPA-1a-Variante im Vergleich zur HPA-1b-Variante 

nach Stimulation mit dem Inside-out-Agonisten PMA scheint auf den ersten Blick den 

theoretischen Erwartungen zu widersprechen. Allerdings konnte in einem weiteren 

Experiment gezeigt werden, dass bei der HPA-1b-Variante die Rezeptoruntereinheiten 

ursprünglich bereits weiter voneinander entfernt sind und sie zudem bei Behandlung mit PMA 

geringer aktiviert werden (Abb. 15). Eine mögliche, wenn auch eher spekulative Erklärung 

wäre, dass die HPA-1b-Variante im Ruhezustand in einer voraktivierten Form vorliegt und 

deshalb durch PMA nur noch bedingt stimuliert werden kann. Die Outside-in-Agonisten Mn2+

und Fibrinogen könnten ihrerseits  so stark wirken, dass sie diesen schwachen Effekt 

überlagern. 

Bemerkenswert ist, dass die HPA-1a- bzw. HPA-1b-Rezeptorvarianten unterschiedlich auf 

die Outside-in- und auf die Inside-out-Agonisten reagieren, wobei die Fluoreszenzabnahme 
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der HPA-1b-Variante nach Stimulation mit einem Outside-in-Agonisten der stärkeren 

Aktivierung des Rezeptors zugesprochen wird.  

4.3.2 Charakterisierung der Rezeptorvarianten unter Strömungsbedingungen 

Im menschlichen Körper sind die Thrombozyten starken Scherkräften ausgesetzt. In früheren 

Publikationen konnte gezeigt werden, dass diese Scherkräfte selbst einen aktivierenden Effekt 

auf αIIbβ3-Integrin haben (Ozaki, 2005; Ruggeri, 2007; Nesbitt, 2009). 

Um festzustellen, ob Scherkräfte die Adhäsion von αIIbβ3-Integrinen modulieren können, 

wurde die Adhäsion von HPA-1a- und HPA-1b-exprimierenden HEK293-Zellen an 

immobilisiertem Fibrinogen in Gegenwart von Scherkräften untersucht (Abb. 17).  

In einer früheren Arbeit konnte gezeigt werden, dass ab einer Scherrate von 800 s-1 HPA-1b- 

exprimierende Zellen signifikant häufiger an immobilisiertem Fibrinogen adhärieren als 

HPA-1a-exprimierende Zellen und dass ab 1600 s-1 80 % der HPA-1a-Zellen abreißen, 

während es im Falle von HPA-1b nur 20 % sind (Doktorarbeit am Institut für 

Hämostaseologie und Transfusionsmedizin: Chahem et al., noch nicht publizierte Daten). 

Dieser Befund konnte in dieser Arbeit unterstützt werden. Bei der FRET-Analyse zeigte sich 

ab einer Scherrate von 800 s-1 eine signifikante Signalabnahme bei den HPA-1b- 

exprimierenden Zellen im Vergleich zu den HPA-1a-exprimierenden Zellen (Abb. 17). 

Obwohl die Experimente in Zellkulturmedium und nicht im Blut, mit HEK293-Zellen und 

nicht mit Thrombozyten, welche eine andere Oberflächenbeschaffenheit als die HEK293-

Zellen aufweisen, durchgeführt wurden, kann man sagen, dass die höheren Scherraten (ab 

800 s-1)  den arteriellen Strömungsverhältnissen in den Gefäßen nahe kommen. Unter den 

schwächeren venösen Strömungsverhältnissen war hingegen kein signifikanter Unterschied 

zwischen HPA-1a- und HPA-1b-exprimierenden Zellen zu erkennen.  

Basierend auf dieser Beobachtung kann daraus geschlossen werden, dass die HPA-1b-

exprimierenden Zellen stärker adhärieren als die HPA-1a-exprimierenden Zellen. Dieses 

Ergebnis steht im Einklang mit anderen Arbeiten (Vijayan, 2003), die eine höhere Affinität 

für αIIbβ3-Integrin zu Gunsten der HPA-1b-Variante in Verbindung mit genannten Scherraten 

bringen (Tzima, 2001). 

Die Befunde stimmen mit einer in vielen klinisch-epidemiologischen Studien gefundenen 

Assoziation überein, die die HPA-1b-Rezeptorvariante mit arteriellen, nicht aber mit venösen 

Thrombosen in Einklang bringen (Ridker, 1997; Zotz, 1998; Hooper, 1999; Larsson, 1999; 

Renner, 2001; Zotz, 2000; Zotz, 2005). So  ist denkbar, dass durch HPA-1b-exprimierende 

Thrombozyten gebildete Thromben eine höhere Stabilität aufweisen. Dies stimmt überein mit den 
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Beobachtungen aus früheren Arbeiten, die zeigten, dass die Blutgerinnsel-Retraktion durch die 

Beteiligung von HPA-1b-Thrombozyten verstärkt wird (Cadroy, 2001). 

Eine mögliche Erklärung für diese Beobachtung könnten Oberflächenplasmonresonanz-

Spektroskopie-Studien liefern, die zeigten, dass die αIIbβ3-Fibrinogenbindung aus zwei 

aufeinanderfolgenden Prozessen besteht, nämlich aus einer schnellen Reaktion mit einem 

reversiblen niedrigen Affinitätskomplex und einer anschließend langsameren Reaktion mit 

einem hohen Affinitätskomplex (Huber, 1995). Es ist möglich, dass durch die gemeinsame 

Präsenz von Scherkräften und einer veränderten Aminosäure (HPA-1a (Leu33) und HPA-1b 

(Pro33)) die Bindungskinetik des αIIbβ3-Integrins an Fibrinogen beeinflusst wird. 

4.4 Quantifizierung der Src418-Kinase unter statischen Bedingungen 

Die Aktivierung des αIIbβ3-Integrins führt zur einer Reihe intrazellulärer Prozesse wie der 

Freisetzung von Kalzium-Ionen, der Initiierung des Phosphoinositid-Metabolismus, der 

Zytoskelett-Reorganisation und der Tyrosin-Phosphorylierung von Proteinen. Beim 

letztgenannten Prozess spielen Protein-Kinasen wie die Tyrosin-Kinasen der Src-Familie eine 

entscheidende Rolle. Diese Src-Kinasen können von vielen thrombozytären Rezeptor-

Agonisten aktiviert werden, wobei eine kleine Menge von Src-Kinasen (ca. 5 %) konstitutiv 

an die zytoplasmatische β3-Schwanz-Domäne gebunden vorkommt und  nach 

Fibrinogenbindung schnell aktiviert wird (Arias-Salgado, 2003; Obergfell, 2002). Daraus 

resultiert eine lokale Src-Kinase-Konzentrationserhöhung, es kommt zu einer trans-

Autophosphorylierung des Aktivierungsloops und dadurch zu einem stabilen αIIbβ3-Integrin-

Aktivierungsstadium (Harrison, 2003). Während dieses Prozesses wird eine weitere Kinase, 

die Spleen-Tyrosin-Kinase (Syk), an die β3-Schwanz-Domäne rekrutiert und durch Src 

aktiviert (Obergfell, 2002), wobei Syk-Kinase und Src-Kinase verschiedene Substrate 

phosphorylieren, welche beim Signaling an das Aktin-Zytoskelett beteiligt sind (Obergfell, 

2001). Ein Beispiel hierfür ist Talin, das an die zytoplasmatische Schwanz-Domäne des 

Integrins bindet (Calderwood, 2004; Moser, 2008; Nieswandt, 2007; Petrich, 2007) und in 

den zu untersuchenden Zellen exprimiert wird. 

In der hier vorliegenden Arbeit wurde mittels Western-Blot und anschließender Densitometrie die 

aktivierte Form der Src418-Kinase (Src pY418) quantifiziert (Abb. 20). Die Stimulierung mit 

PMA führte zu keinem detektierbaren Unterschied zwischen den beiden Rezeptorvarianten. Die 

Stimulierung mit Mn2+ und immobilisiertem Fibrinogen führte hingegen zu einer stärkeren 

Phosphorylierung der Src418-Kinase bei  HPA-1b- exprimierenden Zellen. Die vorherige 

Behandlung mit dem αIIbβ3-Integrin-Antagonist Abciximab blockierte diesen Effekt. Die hier 
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erhaltenen Ergebnisse stehen im Einklang mit den Beobachtungen anderer Arbeitsgruppen 

(Vijayan, 2000).  

Die Src pY418-Kinase-Aktivität der beiden Rezeptorvarianten scheint sich demnach nur unter 

dem Einfluss von Outside-in-Agonisten zu unterscheiden. Die dabei gemessene höhere 

Aktivität in den HPA-1b-exprimierenden Zellen könnte als ein weiterer Hinweis auf einen 

höheren Aktivierungsstatus dieser Zellen nach Outside-in-Signaling interpretiert werden. 

4.5 Schlussfolgerung 

Die Ergebnisse, die hier dargestellt werden, zeigen Konformationsänderungen in den 

zytoplasmatischen Integrin-Domänen, die mit der Aktivierung in lebenden Zellen assoziiert 

sind (Takagi, 2002; Lu, 2001; Takagi, 2001).  

In dieser Arbeit ist es gelungen, die αIIbβ3-Integrin-abhängigen Signalprozesse zu untersuchen 

und diese zwischen HPA-1a und HPA-1b zu vergleichen, um Aktivierungsunterschiede 

zwischen diesen aufzudecken. Der Pro→Leu-Aminosäureaustausch an Position 33 in der β3-

Untereinheit ist extrazellulär und befindet sich in der PSI-Domäne, nahe der 

Ligandenbindungsdomäne. Es konnte gezeigt werden, dass der Aminosäureaustausch bei 

Rezeptoraktivierung zu unterschiedlich starken Konformationsänderungen führt. Die Ergebnisse 

zeigen, dass HPA-1b-exprimierende Zellen im Vergleich zu HPA-1a-Zellen eine stärker 

Konformationsänderung erfahren. Dieses Ergebnis beruht auf einer unterschiedlichen 

Verarbeitung des Outside-in-Signaling. Die funktionellen Unterschiede unterstützen die 

epidemiologischen Assoziationsstudien zwischen der genetischen und der thrombozytären 

Komponente koronarer Herzkrankheiten. Genotypisierungsstudien von an Myokardinfarkten 

verstorbenen Patienten zeigen, dass der HPA-1b-Genotyp stark mit der Bildung von Thromben in 

den Koronararterien der Patienten assoziiert ist (Mikkelsson, 1999; Mikkelsson, 2000).  

Des Weiteren liefert diese Arbeit experimentelle Beweise dafür, dass die Adhäsion an 

Fibrinogen durch die thrombozytäre HPA-1b-Rezeptorvariante moduliert wird. Diese 

Modulation wird durch die spezifischen Rezeptor-Liganden-Wechselwirkungen und 

Schergeschwindigkeiten bestimmt. In Experimenten, welche unter flussdynamischen 

Bedingungen mit exprimierenden HPA-1a- und HPA-1b-Zellen durchgeführt wurden, 

konnten signifikante Unterschiede in der Zelladhäsion auf immobilisiertem Fibrinogen 

detektiert werden. Der Vergleich mit statischen Bedingungen lässt den Rückschluss zu, dass 

ein erhöhtes thrombotisches Potenzial von HPA-1b-exprimierenden Thrombozyten ausgeht.  

Weitere Studien sind jedoch notwendig, um die an der αIIbβ3-Integrinaktivierung beteiligten 

Mechanismen besser zu verstehen. 
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4.6 Implikationen 

Thrombozyten sind maßgeblich an der Entstehung arterieller Thrombosen beteiligt, denn sie 

sind das zelluläre Element der primären Hämostase. Die Thrombozyten bilden Aggregate, die 

eine Gefäßläsion verschließen können. Vermittelt wird dieser Vorgang überwiegend vom 

thrombozytären αIIbβ3-Integrin. Die Liganden binden an den Rezeptor, wodurch es zu einer 

Rezeptorkonformationsänderung mit anschließender Aktivierung der Thrombozyten mit einer 

Aktin-Zytoskelett-Reorganisation kommt. Bei der Rezeptorkonformation werden hochaffine 

Bindungsstellen freigelegt, die nun in der Lage sind, lösliches Fibrinogen irreversibel zu 

binden. Die transmembranäre Signaltransduktion ist damit für die Blutstillung bei vaskulären 

Verletzungen und für pathologische Thrombosen mitverantwortlich, die zu Myokardinfarkten 

führen können (Xiao, 2004). 

So werden Risikopatienten αIIbβ3-Antagonisten präventiv verabreicht, um kardiale 

Komplikationen zu vermeiden. Thrombosefunktionshemmer kommen zum Therapieeinsatz 

bei Thrombosen, Infarkten und Blutgerinnseln. Vor allem helfen die Medikamente zur 

Vorbeugung und Behandlung von Infarkten und Schlaganfällen.  
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Zusammenfassung 
Integrine sind Zelladhäsionsmoleküle mit wichtigen Funktionen z. B. in der Immunität und 

Hämostase. Beim αIIbβ3-Integrin handelt es sich um einen thrombozytenspezifischen 

Rezeptor, dessen zentrale Aufgabe die Bindung von löslichem Fibrinogen an der Oberfläche 

aktivierter Thrombozyten ist, wodurch es zur Vernetzung bzw. Aggregation der 

Thrombozyten kommt. Eine der am häufigsten untersuchten polymorphen Varianten des 

αIIbβ3-Integrins ist der Leucin (HPA-1a)- zu Prolin (HPA-1b)-Austausch an Position 33 der 

β3-Untereinheit. Dieser ist in der PSI-Domäne, nahe der Ligandenbindungsdomäne lokalisiert 

und bewirkt eine Allosterie des Rezeptors. Bei der Mechanotransduktion sollte eine 

gegenseitige Wechselbeziehung zwischen Allosterie und Outside-in- bzw. Inside-out-

Signaling messbar in Erscheinung treten. 

Epidemiologische Assoziationsstudien zwischen der genetischen und der thrombozytären 

Komponente koronarer Herzkrankheiten werden durch experimentell funktionelle 

Unterschiede der polymorphen αIIbβ3-Integrin-Varianten unterstützt. Genotypisierungsstudien 

von an Myokardinfarkten verstorbenen Patienten zeigen, dass der HPA-1b-Genotyp stark mit 

der Bildung von Thromben in den Koronararterien der Patienten assoziiert ist. Die 

Erforschung der Rezeptor-Varianten und ihre allosterischen Veränderungen, die zu diesem 

Pathomechanismus führen ist von großem Interesse, nicht zuletzt weil sie die 

Thrombozytenaktivität modulieren. 

Mittels Fluoreszenz-Resonanzenergietransfers (FRET) wurde der Abstand zwischen den 

zytoplasmatischen Domänen der α- und β-Untereinheit in lebenden Zellen untersucht. Es 

sollten Rückschlüsse auf Rezeptoraktivierung bzw. auf die Konformation gezogen werden. In 

dieser Arbeit konnte gezeigt werden, dass der Aminosäureaustausch bei Rezeptoraktivierung 

zu unterschiedlich starken Konformationsänderungen führt. Die Experimente zeigten, dass 

HPA-1b-exprimierende Zellen im Vergleich zu HPA-1a-Zellen stärker adhärieren. Diese 

gesteigerte Adhäsion korreliert mit einer Verstärkung des Outside-in-Signaling. Des Weiteren 

liefert diese Arbeit experimentelle Beweise dafür, dass die Adhäsion an Fibrinogen durch die 

thrombozytäre HPA-1b-Rezeptorvariante moduliert wird. Diese Modulation wird durch die 

spezifischen Rezeptor-Liganden-Wechselwirkungen und Schergeschwindigkeiten bestimmt. 

In Experimenten, welche sowohl unter flussdynamischen Bedingungen als auch unter 

statischen Bedingungen mit exprimierenden HPA-1a- und HPA-1b-Zellen durchgeführt 

wurden, konnten signifikante Unterschiede in der Zelladhäsion auf immobilisiertem 

Fibrinogen detektiert werden. Die unter dem Einfluss von Ouside-in-Agonisten gemessene 

höhere Src pY418-Kinase-Aktivität in den HPA-1b-exprimierenden Zellen könnte als ein 

weiterer Hinweis auf einen höheren Aktivierungsstatus dieser Zellen in Bezug auf das 

Outside-in-Signaling interpretiert werden. Die Ergebnisse dieser Arbeit lassen 

zusammenfassend den Rückschluss zu, dass die Konformation der HPA-1b-Variante 

ursächlich für das thrombotische Potential verantwortlich ist. Damit konnte diese Arbeit die 

Hypothese bestätigen, dass die HPA-1b-Variante mit einem prothrombotischen Phänotyp 

assoziiert sind.  
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Summary 

Integrins are cell adhesion molecules with important functions in immunity and hemostasis. 

αIIbβ3 integrin is a platelet-specific receptor with the central task of binding soluble 

fibrinogen to the surface of activated platelets. This process results in cross-linking and 

aggregation of platelets. One of the most widely studied polymorphic variants of the αIIbβ3 

integrin is the leucine (HPA-1a) - to proline (HPA-1b) exchange at position 33 of the β3 

subunit. This is located in the PSI domain near the ligand binding domain of the receptor and 

causes an allostery. 

Epidemiological association studies between the genetic and the platelet component of 

coronary heart disease are supported by experimental functional differences in polymorphic 

αIIbβ3 integrin variants. Genotyping of patients who died of myocardial infarction show that 

the HPA-1b genotype is strongly associated with the formation of thrombi in the coronary 

arteries of patients. The study of the receptor variants and their allosteric changes leading to 

pathogenic mechanism is of great interest, because the receptor modulates platelet activity. 

The distance between the cytoplasmic domains of the α-and β-subunit in living cells was 

examined by fluorescence resonance energy transfer (FRET). The aim was to investigate the 

receptor activation and allostery, respectively. In this study it was shown that the amino acid 

replacement results in receptor activation to different degrees of conformational changes. The 

experiments showed that HPA-1b-expressing cells adhere stronger compared to HPA-1a cells. 

This increased adhesion is correlated with a reinforcement of the outside-in signaling. 

Furthermore, this work provides experimental evidence that the adhesion to fibrinogen is 

modulated by the platelet HPA-1b receptor variant. This modulation is determined by the 

specific receptor-ligand interactions and shear rates. Experiments were performed under 

dynamic flow and static conditions using HPA-1a and HPA-1b expressing cells. Significant 

differences were detected in cell adhesion on immobilized fibrinogen. Under the influence of 

outside-agonists we measured a higher pY418 Src kinase activity in HPA-1b-expressing cells. 

This could be interpreted as a further indication of a higher activation status of these cells in 

relation to the outside-in signaling. The results conclude that the conformation of HPA-1b 

variant is originally responsible for the thrombotic potential. This could confirm the 

hypothesis that the HPA-1b variant associated with a prothrombotic phenotype. 
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Anhang 

Auswertung zur 2.7.4 FRET-Analysen am Mikroskop 

1. ImageJ starten. 
2. Plugins→Macros→Install→convertimagetostack→
3. Plugins→Macros→converimagetostack→Choose a Directory→Ordner wählen 
4. File prefix: „ „→OK→#Stacks: „7“→OK→#Slices per Stack: „20“→OK→First frame:“Dateiname“ 
5. Programm fügt Slices zu Stack und berechnet diese. 
6. File→open→Stack→Stack 1 auswählen→Image→Color→Split Channels 
7. Zellen auswählen: 

Analyze→Tools→ROI Manager→Zelle markieren→ROI Manager add 
8. Kanäle auswählen: 

Kanal green (CFP-fluoreszenz) auswerten: Plugins→Stacks→MeasureStack→
Daten in Exel-Tabelle kopieren. 
Kanal red (YFP-fluoreszenz) auswerten: Plugins→Stacks→MeasureStack→
Daten in Exel-Tabelle kopieren. 

Macro: converimagetostack (erstellt in Zusammenarbeit mit Dalli Deniz; Informatik Master Studiengang)
// "ConvertImageToStack" 
// 
// Opens a sample of laser images 
// creates a stack   
// split channels 
// Measures intensity of red and green channel 

// parameters (images/stack,file params) 
  path = getDirectory("Choose a Directory"); 
  prefix = getString("File prefix", "default"); 
  stacks = getNumber("# Stacks:",0);  
  slices = getNumber("# Slices per stack:",0); 
  start  = getNumber("First frame:",0);  

  File.makeDirectory(path+"/stacks") 

// setup "globals" 
  size = stacks * slices; 
  mean_red   = newArray(size); 
  area_red   = newArray(size); 
  mean_green = newArray(size);  
  area_green = newArray(size); 
   
  for (j=0; j < stacks;j++) { 

    for (i=start + (j*slices); i < (start + ((j+1)*slices)) ; i++) { 
   open(path+"/"+ prefix + i + ".png"); 
    } 

    // transforms open images to stack 
    run("Images to Stack"); 
    // save stack 
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    save(path+"/stacks/stack"+(j+1)+".tif"); 
    run("Split Channels"); 
   
    // close unused channel 
    selectWindow("stack"+(j+1)+".tif (blue)"); 
    close(); 

    // measure red channel   
    selectWindow("stack"+(j+1)+".tif (red)"); 
    //run("Measure Stack"); 

    for (n = 1; n <= nSlices; n++) { 
     setSlice(n); 
     List.setMeasurements; 
     area_red[(j*slices) + n-1] = List.getValue("Area");    
     mean_red[(j*slices) + n-1] = List.getValue("Mean"); 
    } 
     close(); 
     
     
    // measure green channel  
    selectWindow("stack"+(j+1)+".tif (green)"); 
    for (n = 1; n <= nSlices; n++) { 
      setSlice(n); 
      List.setMeasurements; 
      area_green[(j*slices) + n-1] = List.getValue("Area");    
      mean_green[(j*slices) + n-1] = List.getValue("Mean"); 
    } 
    close(); 
  } 
   

  // write measurements to file 

  f = File.open(path+"stacks/Measurement.csv"); // display file open dialog 
  print(f,"Measurement|Red channel - Area/Size[px]|Red Channel intensity (0-255)|Green channel - 
Area/Size[px]|Green Channel  intensity (0-255)"); 
  for (i=0; i<stacks; i++) { 
    for (j=0; j<slices; j++) { 
      n = slices * i + j; 
      print(f,(i+1) + "-" + (j+1) +"|" + area_red[n] + "|" + mean_red[n] + "|" + area_green[n] + "|" + 
mean_green[n]); 
    } 
  }  
   
  File.close(f) 
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Auswertung zur 2.7.2 Basale FRET-Effizienz über Akzeptor-Bleaching 

1. ImageJ starten. 
2. File→Open→Image vor dem Bleaching auswählen. 
3. Image→Color→Split Channels 
4. Zellen auswählen: 

Analyze→Tools→ROI Manager→Zelle markieren→ROI Manager add 
5. Kanäle auswählen: 

Kanal green (CFP-fluoreszenz) auswerten: Analyze→Measure→Daten in Exel-Tabelle kopieren. 
Kanal red (YFP-fluoreszenz) auswerten: Analyze→Measure→Daten in Exel-Tabelle kopieren. 

6. File→Open→Image nach dem Bleaching auswählen. 
7. Image→Clolor→Split Channels 
8. Zellen auswählen: 

Analyze→Tools→ROI Manager→Zelle markieren→ROI Manager add 
9. Kanäle auswählen: 

Kanal green (CFP-fluoreszenz) auswerten: Analyze→Measure→Daten in Exel-Tabelle kopieren. 
Kanal red (YFP-fluoreszenz) auswerten: Analyze→Measure→Daten in Exel-Tabelle kopieren. 

Plasmidkarte für pcDNA3.1: 


